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About  this  guide  

This guide contains information about installing and using the master console. 

v   Chapter 1, “Overview,” on page 1 provides an overview of the master console. 

v   Chapter 2, “Concepts,” on page 3 discusses concepts that will help you 

understand how the master console works. 

v   Chapter 3, “Planning for the master console,” on page 9 describes how to plan 

for the installation of the master console. 

v   Chapter 4, “Installing master console software,” on page 17 provides the 

procedures required to install the master console, including how to use the 

master console installation wizard. 

v   Chapter 5, “Configuring the master console,” on page 35 explains how to 

configure the master console. 

v   Chapter 6, “Managing the master console,” on page 47 provides an overview of 

the tasks that you can perform from the master console. 

v   Chapter 7, “Removing master console software,” on page 57 provides a 

high-level overview of the procedures for uninstalling the master console 

software. 

v   Chapter 8, “Upgrading the master console to version 3.2,” on page 61 explains 

how to upgrade the master console software. 

v   Chapter 9, “Troubleshooting the master console,” on page 65 provides 

information about resolving problems with the master console.

Who should use this guide 

This topic describes the audience for this guide. 

The IBM System Storage Master Console for SAN File System and SAN Volume 

Controller: Installation and User’s Guide should be used by the person or persons 

assigned to manage SAN File System or SAN Volume Controller on a regular basis. 

Important:  If you are a SAN File System user, refer to the version 2.4.01 IBM 

TotalStorage Master Console Installation and User’s Guide. 

An administrator should have experience in at least the following skills, or have 

access to personnel with experience in these skills: 

v   Microsoft® Windows® and Windows Advanced Server (depending on your client 

environment) 

v   Linux® system administration 

v   Networking and network management 

v   SAN management 

v   Command-line interface scripting 

v   Critical business issues (such as backup, disaster recovery, and security)

Conventions and notices 

This topic describes the notice conventions used in this publication. 

The following notices are used in this publication and convey these specific 

meanings: 

Note:  These notices provide important tips, guidance, or advice.
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Attention:  These notices indicate possible damage to programs, devices, or data. 

An attention notice appears before the instruction or situation in which damage can 

occur.

 CAUTION: 

These notices indicate situations that can be potentially hazardous to you. A 

caution notice appears before the description of a potentially hazardous 

procedure step or situation.

 DANGER

These notices indicate situations that can be potentially lethal or extremely 

hazardous to you. A danger notice appears before a description of a 

potentially lethal or extremely hazardous procedure step or situation.

Emphasis 

Different typefaces are used in this guide to show emphasis. 

The following typefaces are used to show emphasis: 

 Boldface Text in boldface represents menu items and 

command names. 

Italics Text in italics is used to emphasize a word. 

In command syntax, it is used for variables 

for which you supply actual values, such as 

a default directory or the name of a cluster. 

Monospace Text in monospace identifies the data or 

commands that you type, samples of 

command output, examples of program code 

or messages from the system, or names of 

command flags, parameters, arguments, and 

name-value pairs.
  

Web  sites 

This topic discusses any Web sites that offer additional, up-to-date information. 

The following Web sites have additional and up-to-date information about SAN File 

System: 

v   www.ibm.com/storage/support/sanfs/ 

v   www.ibm.com/storage/software/virtualization/sfs

The following Web site has additional and up-to-date information about SAN 

Volume Controller: 

v   www.ibm.com/storage/support/2145/

Master console library and related publications 

A list of publications that are related to this product are provided to you for your 

reference. 

The information in this section lists and describes the following publications: 
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v   The publication that is available for the IBM System Storage master console for 

SAN File System and SAN Volume Controller 

v   Other IBM publications that relate to the master console

Master console library 

The following publication is available in the master console library. It is provided in 

softcopy on the IBM® System Storage Master Console Publications CD and at 

http://www.ibm.com/storage/support/2145. To use the CD, insert it in the CD-ROM 

drive. If the CD does not launch automatically, follow the instructions on the CD 

label. 

Note:  The softcopy version of these publications are accessibility-enabled for the 

IBM Home Page Reader. 

v   IBM System Storage Master Console for SAN File System and SAN Volume 

Controller: Installation and User’s Guide, GC30-4090 

This publication provides detailed procedures to set up and cable the hardware, 

install and upgrade the master console software, configure the software 

components, and troubleshoot and resolve problems.

Other IBM publications 

The following tables list and describe other IBM publications that contain additional 

information related to the master console. 

SAN File System publications 

The following publications are related to the SAN File System. Unless otherwise 

noted, these publications are available in Adobe portable document format (PDF) 

from the following Web site: 

http://www.ibm.com/software/tivoli/products/totalstorage-sfs/ 

 Title Description Order number 

IBM TotalStorage®  SAN File 

System Installation and 

Configuration Guide 

This publication provides 

detailed procedures to set up 

and cable the hardware, 

install and upgrade the SAN 

File System software, 

perform the minimum 

required configuration, and 

migrate existing data. 

GA27-4316 

IBM TotalStorage SAN File 

System Planning Guide 

This publication provides 

detailed procedures to plan 

the installation and 

configuration of SAN File 

System. 

GA27-4344 

IBM TotalStorage SAN File 

System Maintenance and 

Problem Determination Guide 

This publication provides 

instructions for adding and 

replacing hardware 

components, monitoring and 

troubleshooting the system, 

and resolving hardware and 

software problems 

GA27-4318
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SAN Volume Controller publications 

The following publications are related to the SAN Volume Controller. Unless 

otherwise noted, these publications are available in Adobe portable document 

format (PDF) from the following Web site: 

http://www.ibm.com/storage/support/2145 

 Title Description Order number 

IBM System Storage SAN 

Volume Controller: 

Command-Line Interface 

User’s Guide 

This guide describes the 

commands that you can use 

from the SAN Volume 

Controller command-line 

interface (CLI). 

SC26-7544 or SC26-7903 

IBM System Storage SAN 

Volume Controller: 

Configuration Guide 

This guide provides 

guidelines for configuring 

your SAN Volume Controller 

SC26-7543 or SC26-7902 

IBM System Storage SAN 

Volume Controller: Host 

Attachment Guide 

This guide provides 

guidelines for attaching the 

SAN Volume Controller to 

your host system. 

SC26-7575 or SC26-7905 

IBM System Storage SAN 

Volume Controller: 

Installation Guide 

This guide includes the 

instructions the service 

representative uses to install 

the SAN Volume Controller. 

SC26-7541 or GC26-7900 

IBM System Storage SAN 

Volume Controller: Planning 

Guide 

This guide introduces the 

SAN Volume Controller and 

lists the features you can 

order. It also provides 

guidelines for planning the 

installation and configuration 

of the SAN Volume 

Controller. 

GA22-1052 or GA32-0551 

IBM System Storage SAN 

Volume Controller: Service 

Guide 

This guide includes the 

instructions the service 

representative uses to 

service the SAN Volume 

Controller. 

SC26-7542 or GC26-7901

  

How to order IBM publications 

The publications center is a worldwide central repository for IBM product 

publications and marketing material. 

The IBM publications center 

The IBM publications center offers customized search functions to help you find the 

publications that you need. Some publications are available for you to view or 

download free of charge. You can also order publications. The publications center 

displays prices in your local currency. You can access the IBM publications center 

through the following Web site: 

http://www.ibm.com/shop/publications/order/ 
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Publications notification system 

The IBM publications center Web site offers you a notification system for IBM 

publications. Register and you can create your own profile of publications that 

interest you. The publications notification system sends you a daily e-mail that 

contains information about new or revised publications that are based on your 

profile. 

If you want to subscribe, you can access the publications notification system from 

the IBM publications center at the following Web site: 

http://www.ibm.com/shop/publications/order/ 

How to send your comments 

Your feedback is important to help us provide the highest quality information. If you 

have any comments about this book or any other documentation, you can submit 

them in one of the following ways: 

v   e-mail 

Submit your comments electronically to the following e-mail address: 

starpubs@us.ibm.com 

Be sure to include the name and order number of the book and, if applicable, the 

specific location of the text you are commenting on, such as a page number or 

table number. 

v   Mail 

Fill out the Readers’ Comments form (RCF) at the back of this book. If the RCF 

has been removed, you can address your comments to:

International Business Machines Corporation 

RCF Processing Department 

Department 61C 

9032 South Rita Road 

Tucson, Arizona 85775-4401 

U.S.A. 

Summary of changes 

This document contains terminology, maintenance, and editorial changes. 

Changes made in release 3.2

Note:  In this edition, the brand ″IBM TotalStorage″ has been replaced with ″IBM 

System Storage″ when referring to the master console and the SAN Volume 

Controller. 

Technical changes or additions to the text and illustrations are indicated by a 

vertical line to the left of the change. This summary of changes describes new 

functions that have been added to this release and the previous release. 

The following list describes the changes made to the IBM System Storage Master 

Console for SAN File System and SAN Volume Controller: Installation and User’s 

Guide in release 3.2. 

New information 

New information in release 3.2 of this guide includes: 
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v   Information clarifying the version of Tivoli® Storage Area Network Manger 

(Tivoli SAN Manager) has been added. 

v   A Windows 2003 example has been added to the instructions for 

mirroring the boot drive. 

v   A new section for upgrading the master console to version 3.2 was 

added. 

v   Several topics about setting up error notifications for the SAN Volume 

Controller were added.

Changed information 

Changed information in release 3.2 of this guide includes: 

v   The information about remote access and the role of the IBM Connection 

Manager in that access has been enhanced. 

v   The conceptual information about service alerts and e-mail notifications 

was updated. 

v   The planning information for the master console has been enhanced and 

updated. 

v   Fibre Channel cables are no longer available with the master console. 

v   The system memory requirements for the hardware where the master 

console is installed is now 4 GB. 

v   The installation overview and several of the installation topics master 

console have been enhanced and updated. 

v   The configuration overview and most of the existing configuration topics 

were enhanced. 

v   Some of the troubleshooting information was enhanced or clarified.

Deleted information 

Information that was deleted from release 3.2 of this guide includes: 

v   The hardware master console configuration steps have been removed 

from the planning section and incorporated into the configuring section. 

v   Topics and information related to Fibre Channel connections were 

removed since Fibre Channel connections are no longer available with 

the master console. 

v   The information about setting up service alert for the SAN Volume 

Controller was removed and replaced by several topics about setting up 

error notifications for the SAN Volume Controller 

v   The section for upgrading the master console to version 3.1 was 

removed and replaced with information about upgrading to version 3.2.

Changes made in release 3.1 

The following list describes the technical changes and enhancements made to 

master console in release 3.1. 

Installation enhancements 

Installation enhancements for the master console in release 3.1 include: 

v   DS4000 Storage Manager Client (FAStT Storage Manager Client) and 

IBM TotalStorage SAN Volume Controller Console are optional 

components 

v   The master console information center is installed using the IBM 

WebSphere® Help System and is installed as a service. 

v   The installation wizard checks your hardware for prerequisites before 

installing the software. 
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v   The installation wizard can be restarted if the installation is interrupted or 

fails.

Upgrade enhancements 

You can upgrade an existing software-only master console (releases 2.3 or 

2.4) or an existing hardware master console (releases 1.3 or 1.4) using the 

master console 3.1 installation wizard.

Note:  In release 3.1, the product is referred to as master console.
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Chapter  1.  Overview  

This topic provides an overview of the master console. 

Important:  If you are a SAN File System user, refer to the version 2.4.01 IBM 

TotalStorage Master Console Installation and User’s Guide. 

The master console provides a single point from which to manage the IBM 

TotalStorage SAN File System and the IBM System Storage™ SAN Volume 

Controller. 

The master console provides you with the following capabilities: 

v   Access to the metadata servers in the SAN File System cluster. You can access 

these components: 

–   SAN File System console through a Web browser. 

–   Administrative command-line interface, through a Secure Shell (SSH) session. 

–   Any of the metadata server engines in the cluster through an SSH session. 

–   The RSA II adapter for any of the metadata server engines running SAN File 

System software through a Web browser. 

–   Any of the SAN File System clients through an SSH session, a telnet session, 

or a remote-display emulation package, such as Virtual Network Computing 

(VNC), depending on the configuration of the client.

v    Access to the SAN Volume Controller. You can access these components: 

–   SAN Volume Controller console through a Web browser. 

–   Administrative command-line interface, through a Secure Shell (SSH) session. 

When using the master console with the SAN Volume Controller, you must install 

and configure it before configuring the SAN Volume Controller. The installation 

and configuration steps are different between the hardware master console and 

the software-only master console. For the hardware master console (in which the 

software is preinstalled), you must customize the default factory settings. The 

general steps for this are given in Chapter 5, “Configuring the master console,” 

on page 35. 

v   Access to the fibre channel switches and views of your SAN topology using Tivoli 

SAN Manager. 

v   Initiate a VPN connection, which allows an IBM support engineer to remotely 

access the master console. You can monitor that access and disconnect the 

session at any time. In addition, through the use of remote desktop access 

software, such as VNC, the IBM support engineer can view the desktop of the 

master console remotely. 

v   Manage SNMP traps through IBM Director, which can automatically notify IBM 

support personnel in the event of a severe error and can submit e-mail 

notifications to your personnel, such as a systems administrator.

The master console is an optional component for the SAN File System. If you have 

a configuration with only the SAN File System, using the VPN connection for 

remote access is a simpler alternative than setting up the master console. If you 

have a configuration with the SAN Volume Controller (with or without the SAN File 

System), you must use the master console for remote access. 

A note on the two master console product options 

Although you have two options in purchasing the master console product 

(you can buy the master console software and install and configure it on 
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hardware of your choice, or you can buy a hardware platform with the 

operating system and master console software preinstalled), the only 

difference between these two options is the installation and configuration 

process. 

 For the master console software option, the installation and configuration is 

performed by you in a single process managed by the installation wizard, 

as described in this guide. 

 For the preinstalled option, with the software installed on the hardware in 

the manufacturing plant using default settings, you must configure and 

customize the settings as part of its installation process.
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Chapter  2.  Concepts  

This section discusses concepts that will help you understand how the master 

console works. Becoming familiar with the master console components and 

understanding the concepts in this section enables you to use the master console 

most effectively. 

IBM Connection Manager and remote access 

The IBM Connection Manager component of the master console is VPN connection 

software that provides remote access to the SAN Volume Controller Console. 

Remote access allows IBM Support Center personnel to diagnose problems with 

your system. Remote access support can help to greatly reduce service costs and 

shorten repair times, which in turn reduces the impact of any failures on your 

business. 

Remote access gives IBM support personnel full access to the SAN File System or 

the SAN Volume Controller through the master console, including querying and 

controlling the metadata servers and clients, and accessing metadata, log, dump, 

and configuration data. Remote access does not allow access without 

authentication. You must initiate a secure virtual private network (VPN) connection 

from the master console to allow IBM support personnel to remotely access the 

master console. From the master console, the support personnel can establish a 

connection to the SAN File System metadata servers or the SAN Volume Controller 

nodes. However, you can monitor that access and disconnect the session at any 

time. 

In response to an error condition, you initiate a secure connection to the IBM VPN 

server using the IBM Connection Manager. You must provide the customer 

connection ID for the newly created connection to the IBM support personnel. The 

IBM support personnel initiates a secure connection to their VPN server, and then 

establishes a secure connection to the master console over the VPN tunnel using 

the customer connection ID and a pre-authorized account on the master console. 

Finally, IBM support personnel can access the SAN File System metadata server or 

the SAN Volume Controller node through SSH. 

Figure 1 on page 4 shows the remote access architecture: 
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Related tasks 

   “Initiating remote support” on page 50
When IBM is helping you to resolve a problem with your SAN Volume Controller 

or SAN File System, you might receive a request to invoke an IP connection so 

that a remotely based IBM service representative can access the master 

console to collect additional information about the problem.

Service alerts and error notifications 

This topic provides an overview of the service alerts and error notifications. 

You can configure the master console to notify the SAN File System or SAN 

Volume Controller administrators of errors or failure conditions. If you are using 

SAN Volume Controller, you configure the IBM Director to send system 

administrator through e-mail when errors or events are logged or to initiate a 

call-home message to IBM when failures that require service actions are logged by 

the SAN Volume Controller. 

SAN File System 

For SAN File System, a ″service alert″ notifies the system administrator of 

significant errors or failure conditions. SAN File System issues an Simple Network 

Management Protocol (SNMP) trap and sends that trap to the IBM Director Server 

running on the master console in response to a sever error condition. The IBM 

Director Server catches the trap and converts it into a Simple Mail Transfer Protocol 

(SMTP) e-mail message. The e-mail message is then sent to your SMTP mail 

server and then forwarded to the system administrator. The system administrator 

can then call the IBM Support Center. 

Figure 2 on page 5 shows the service alert architecture for SAN File System: 
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Figure 1. Remote access architecture
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SAN Volume Controller 

In response to a sever error condition, SAN Volume Controller issues a Simple 

Network Management Protocol (SNMP) trap and sends that trap to the IBM Director 

Server running on the master console. The IBM Director Server catches the trap 

and converts it into a Simple Mail Transfer Protocol (SMTP) e-mail message. Two 

e-mail messages can be produced: one to the systems administrator in the same 

way as in SAN File System, and another optional e-mail to the IBM support system. 

The optional e-mail to the IBM support system is sent to your SMTP mail server 

and then forwarded to the IBM support system, where it is converted into a problem 

record. 

Figure 3 shows the call-home architecture for the SAN Volume Controller. Note that 

the path to the system administrator (as shown in Figure 2) is not shown in this 

figure: 

 

   Related tasks 

   “Installing the SNMP service” on page 19
This topic describes how to install the SNMP services. 

   “Initiating remote support” on page 50
When IBM is helping you to resolve a problem with your SAN Volume Controller 

or SAN File System, you might receive a request to invoke an IP connection so 
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Figure 3. Call-home architecture for SAN Volume Controller

 

Chapter 2. Concepts 5

|

|
|
|

|

|
|
|

|

|
|
|
|
|
|
|
|
|

|
|
|
|

|

|
|

|
|
|



that a remotely based IBM service representative can access the master 

console to collect additional information about the problem.

Secure Shell (SSH) 

This topic provides an overview of Secure Shell (SSH). 

Secure Shell (SSH), which is implemented through PuTTY, is the communication 

vehicle between the host system that you are using and the following components: 

v   The SAN File System command-line interface (CLI) 

v   The SAN Volume Controller CLI 

v   The master console. 

v   Each of the metadata server engines in the SAN File System cluster, using SSH 

from the master console.

SSH provides a secure communications channel between systems. You can 

configure SSH to use a private/public key pair to establish the secure connection 

This private/public key pair is required for SAN Volume Controller, but it is optional 

for SAN File System. 

If you are using a private/public key pair, the public key must be placed on any 

system to which you want to create an SSH connection (such as the SAN Volume 

Controller nodes or the SAN File System metadata servers and clients). In addition, 

any system to which you want to create an SSH connection must be running an 

SSH server. 

   Related tasks 

   “Generating an SSH key pair using PuTTYgen” on page 24
Although not part of the master console installation wizard, you must generate 

SSH keys for the SAN Volume Controller. You are prompted for these keys 

when you install the SAN Volume Controller Console. You can leave the 

installation wizard in its current state while you generate the SSH keys. 

Software components 

This topic describes the software components that are provided for the master 

console. 

The following software is provided for the master console: 

v   Adobe Reader 

v   DB2® 

v   DS4000 Storage Manager Client (FAStT Storage Manager Client) 

v   IBM Director 

v   PuTTY (SSH client software) 

v   SAN Volume Controller Console 

v   IBM Tivoli Storage Area Network Manager (Tivoli SAN Manager) 

v   IBM Connection Manager

Note:  The version of Tivoli SAN Manager that is included with the master 

console is the IBM Tivoli Bonus Pack for SAN Management, which 

provides the same SAN management capabilities as Tivoli SAN Manager 
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for environments up to 64 SAN switch ports. If more than 64 SAN ports 

are required in your enterprise, you can purchase the full Tivoli SAN 

Manager product.
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Chapter  3.  Planning  for  the  master  console  

This topic provides an overview of the planning tasks that you must complete 

before you install and configure the master console. 

Note:  The hardware-related prerequisites in this section are relevant only when you 

are installing and configuring the master console software on hardware of 

your choice (that is, when you have purchased only the master console 

software). 

Perform the following steps to plan for the installation of the master console: 

v   Verify that you have met the hardware and software prerequisites. 

v   Determine the cabling required for your configuration. 

v   Determine how the ports on the master console will be configured. 

v   Determine the IP addresses to be used for the master console.

The master console must be in the same room as the devices that it supports. In 

addition, place the master console within 50 feet of the SAN File System metadata 

servers or SAN Volume Controller nodes. 

Master console prerequisites 

This topic defines the hardware and software prerequisites that you must obtain for 

the master console. 

Hardware prerequisites 

If you do not already have hardware for the master console, you must obtain a 

rack-mounted, high-performance, highly-reliable Intel® server (such as the IBM 

eServer™ xSeries® 306m or equivalent) with the following options: 

v   One Pentium® 4 processor, minimum 2.6 GHz 

v   Minimum of 4 GB of system memory 

v   Two IDE hard disk drives, minimum 40 GB each. During installation, you will 

mirror these drives. 

v   CD-ROM and diskette drives 

v   Two 1Gb ports for Ethernet connections (fiber or copper) 

v   Keyboard, such as the Space Saver NLS keyboard or equivalent 

v   Monitor, such as Netbay 1U Flat Panel Monitor Console kit without keyboard or 

equivalent 

v   Mouse or equivalent pointing device

Example hardware configuration 

v   IBM xSeries 306m server (1U) 

v   Intel Pentium 4 3.0 GHz processor 

v   4 GB memory DIMM (256 MB comes with base unit) 

v   Two 70 GB IDE hard disk drives (one comes with base unit) 

v   Two 10/100/1000 Copper Ethernet ports on planar 

v   NetBay 1U Flat Panel Monitor Console Kit with US keyboard
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Software prerequisites 

The master console requires that you obtain the following software: 

v   Operating system 

–   The hardware master console is shipped with Windows Server 2003 

preinstalled. 

–   The software master console requires that one of the following operating 

systems is provided on your hardware platform: 

-   Microsoft Windows Server 2003 Enterprise Edition 

-   Microsoft Windows Server 2003 Standard Edition 

-   Microsoft Windows 2000 Server Edition with Service Pack 4 or higher. 

-   Microsoft Windows 2000 with Update 818043. To obtain this update: 

1.   Point your browser to the following Web site: 

http://v4.windowsupdate.microsoft.com/catalog/en/default.asp 

2.   Click Find updates for Windows operating systems. 

3.   Select Windows 2000 Professional SP4. 

4.   Select Advanced search options. 

5.   In the field, Contains these words, enter 818043, and then click 

Search. 

6.   Follow the directions on the Web site to download the update. 

7.   After you download the update, navigate to the location where the 

update was downloaded and run the .exe file to install the update.

v    Microsoft Windows Internet Explorer version 6.0 with Service Pack 1 

v   Antivirus software (not required but necessary to ensure protection of your 

computer). 

v   J2SE Java™ Runtime Environment (JRE) 1.4.2. 

You can obtain JRE 1.4.2 by going to the following Web site and then clicking 

Downloads → Java & Technologies → Java 2 Platform, Standard Edition 1.4 → 

Download J2SE JRE: 

www.sun.com/

Cabling options 

This topic describes the various options for cabling the hardware that runs the 

master console. This information helps you to plan the cabling of the hardware. 

However, to avoid any address conflicts, do not connect the Ethernet cables until 

after you have configured the IP addresses. 

There are a variety of ways to cable the hardware that contains the master console. 

The option you choose depends on your environment as the following list 

discusses: 

v   A single master console that is used for a single SAN File System or SAN 

Volume Controller installation. 

v   A single master console that is shared between a SAN File System installation 

and a SAN Volume Controller installation. 

v   Two master consoles, one for a SAN File System installation and one for a SAN 

Volume Controller installation.

In all cases, the ports on the hardware for the master console is cabled as follows: 

v   One Ethernet port is cabled to your corporate intranet. 

v   One Ethernet port is cabled to the Internet through a corporate firewall. This port 

will be used for remote access functionality.
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Related tasks 

   “Entering IP address for Ethernet port 1” on page 18
This topic describes how to configure the IP address for the external Internet 

connection for remote access (Ethernet port 1). 

   “Entering IP address for Ethernet port 2” on page 18
This topic describes how to configure the IP address for the internal IP network 

connection (Ethernet port 2).

Cabling a single master console machine 

This topic illustrates a cable configuration in which you have a separate machines 

running the master console for SAN File System or SAN Volume Controller. 

Figure 4 shows how you can cable a single master console machine that is used by 

a single SAN File System or a single SAN Volume Controller installation: 

   

Cabling a shared master console machine 

This topic illustrates how to cable one master console machine that is shared 

between the SAN File System and the SAN Volume Controller or for a SAN Volume 

Controller. 

Figure 5 on page 12 shows how you can cable a master console machine in a 

shared environment: 
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Figure 4. Cabling a single master console
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Cabling multiple master console machines 

This topic illustrates a cable configuration in which you have separate master 

console machines for the SAN File System and the SAN Volume Controller. 

Figure 6 on page 13 shows how you can cable multiple machines running master 

consoles: 
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Figure 5. Cabling a shared master console machine
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Specifying port assignments 

You must decide which ports to use for the master console so that you can 

determine the Ethernet cables that you will need. 

Use Table 1 to record the port assignments. 

When filling out Table 1, use the following descriptions 

v   Ethernet port 1: Used for your VPN connection. This port is required if you 

configure the master console to enable remote access. A remote access 

connection can be enabled only when this port has access to an external Internet 

connection. For added security, you can disconnect this port when a remote 

access connection is not being used. 

v   Ethernet port 2: Used to connect to the same IP network to which the SAN 

Volume Controller nodes or the SAN File System metadata server engines are 

connected.

 Table 1. Port assignment table 

Master console Ethernet 

VPN Public Network 

  

Table 2 provides an example of a completed port assignment table. 

 Table 2. Example completed port assignment table 

Master console Ethernet 

VPN Public Network 

Master console Ethernet hub 1, port 6 Ethernet hub 1, port 5
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Figure 6. Cabling multiple master console machines
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Related tasks 

   “Entering IP address for Ethernet port 1” on page 18
This topic describes how to configure the IP address for the external Internet 

connection for remote access (Ethernet port 1). 

   “Entering IP address for Ethernet port 2” on page 18
This topic describes how to configure the IP address for the internal IP network 

connection (Ethernet port 2).

Specifying IP information 

This topic describes the IP configuration information that you specify for the master 

console. 

Complete the master console IP configuration worksheet for the master console. 

When filling out the port assignment table, use the following descriptions. 

v   Machine name: A fully-qualified Domain Name Server (DNS) name for the 

master console. 

v   Master console IP addresses : The addresses that will be used for access to 

the master console. 

v   Gateway IP address: The default gateway IP address used by the master 

console. 

v   Subnet mask : The subnet mask for the master console.

master console IP configuration worksheet 

 master console IP configuration worksheet 

Machine name: 

Ethernet port 1 Ethernet port 2 

master console IP address 

Gateway IP address 

Subnet mask 

  

   Related tasks 

   “Entering IP address for Ethernet port 1” on page 18
This topic describes how to configure the IP address for the external Internet 

connection for remote access (Ethernet port 1). 

   “Entering IP address for Ethernet port 2” on page 18
This topic describes how to configure the IP address for the internal IP network 

connection (Ethernet port 2).

Configuring firewall support 

This topic provides information about your firewall configuration. 

Local Area Connection 1 on the master console must be allowed to connect to the 

IBM Remote Support Gateway through UDP port 500 and UDP port 1701. If you 

have a NAT (network address translation) firewall, allow Local Area Connection 1 on 

the master console to connect to the IBM Remote Support Gateway through UDP 

port 4500. 

Note:  For Remote Support to work, a maximum of two ports must be permitted to 

connect to the Local Area Connection 1 on the master console. Check with 
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your network system administrator to find out if you have access to the 

necessary ports and to gain access, if necessary. 

The following list provides the ports and protocol requirements: 

v   L2TP - UDP 500, UDP 1701 

v   NAT-T - UDP 4500 

v   ESP - IP protocol 50
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Chapter  4.  Installing  master  console  software  

If you purchased the master console software to run on your own hardware, this 

section guides you through the software installation process. If you have purchased 

the hardware preinstalled with the master console software, you can skip the 

software installation tasks and proceed with configuring the master console. 

Before you install the master console software, you must have completed the 

following tasks: 

v   Installed all hardware prerequisites for the master console. 

v   Installed all prerequisite software. 

v   Enabled SNMP services by completing the following steps: 

1.   Click Start → Programs → Control Panel. 

2.   Double-click Add or Remove Programs. 

3.   Select Add/Remove Windows Components. 

4.   Click on the text for Management and Monitoring Tools and click Details. 

5.   Select the Simple Network Management Protocol check box and click OK.

In addition, view the release notes for the master console software on the following 

IBM support Web site for the latest information: 

http://www.ibm.com/storage/support/2145 

You can use the installation wizard to help you install all of the master console 

software components instead of installing each component individually. 

The following tasks are involved in the master console software installation process: 

v   Task 1: Prepare the master console environment 

v   Task 2: Install the master console software by using the installation wizard. 

v   Task 3: Mirror the boot drive

Important:  Other than antivirus software, ensure that the master console software 

is the only type of software that is installed on the hardware that you 

are using for the master console. 

Preparing the master console environment 

This topic provides an overview of the steps that are required to set up the master 

console in preparation for installing the master console software. 

To set up the master console, you must perform the following steps. These steps 

are explained in more detail in other topics in this book. 

1.   Configure the IP address for the Ethernet port that is to be connected to the 

external Internet (Ethernet port 1). “Entering IP address for Ethernet port 1” on 

page 18 provides more details for this step. 

2.   Configure the IP address for the Ethernet port that is to be connected to the 

internal IP network (Ethernet port 2). “Entering IP address for Ethernet port 2” 

on page 18 provides more details for this step. 

3.   Configure the host name for the master console. “Configuring the master 

console host name” on page 19 provides more details for this step. 

4.   Set up the internet browser. “Configuring the browser” on page 19 provides 

more details for this step. 
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5.   Install the SNMP service (if you did not install it when you installed the 

operating system). “Installing the SNMP service” on page 19 provides more 

details for this step.

Entering IP address for Ethernet port 1 

This topic describes how to configure the IP address for the external Internet 

connection for remote access (Ethernet port 1). 

Tip:  After configuring the connection, you can disable it when you are not using 

remote access. 

Perform the following steps to configure the IP address for the external Internet 

connection: 

1.   From the desktop, right-click the My Network Places icon. 

2.   Click Properties. 

3.   Right-click Local Area Connection 1. 

4.   Click Properties. 

5.   Click Internet Protocol (TCP/IP). 

6.   Click Properties. 

7.   Enter all required information for the IP and DNS addresses. 

8.   Click OK until you return to the desktop. 

9.   Connect Ethernet port 1 to the network. 

   Related reference 

   “Specifying IP information” on page 14
This topic describes the IP configuration information that you specify for the 

master console. 

   “Specifying port assignments” on page 13
You must decide which ports to use for the master console so that you can 

determine the Ethernet cables that you will need. 

   “Cabling options” on page 10
This topic describes the various options for cabling the hardware that runs the 

master console. This information helps you to plan the cabling of the hardware. 

However, to avoid any address conflicts, do not connect the Ethernet cables 

until after you have configured the IP addresses. 

Entering IP address for Ethernet port 2 

This topic describes how to configure the IP address for the internal IP network 

connection (Ethernet port 2). 

Perform the following steps to configure the IP address for the internal network 

connection: 

1.   From the desktop, right-click the My Network Places icon. 

2.   Click Properties. 

3.   Right-click Local Area Connection 2. 

4.   Click Properties. 

5.   Click Internet Protocol (TCP/IP). 

6.   Click Properties. 

7.   Type all required information for the IP and DNS addresses. 

8.   Click OK until you return to the desktop. 
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9.   Connect Ethernet port 2 to the network. 

   Related reference 

   “Specifying IP information” on page 14
This topic describes the IP configuration information that you specify for the 

master console. 

   “Specifying port assignments” on page 13
You must decide which ports to use for the master console so that you can 

determine the Ethernet cables that you will need. 

   “Cabling options” on page 10
This topic describes the various options for cabling the hardware that runs the 

master console. This information helps you to plan the cabling of the hardware. 

However, to avoid any address conflicts, do not connect the Ethernet cables 

until after you have configured the IP addresses. 

Configuring the master console host name 

You must set up the master console host name using the IP configuration 

information that you have specified during planning. 

Perform the following steps to configure the host name: 

1.   From the desktop, right-click the My Computer icon and select Properties. 

2.   Click the Network Identification tab. 

3.   Click Properties. 

4.   Enter the master console name in the Computer name field. 

5.   Click More. 

6.   Enter the full path information in the Primary DNS suffix for this computer 

field. 

7.   Click OK until you return to the desktop.

Configuring the browser 

After you install the SAN Volume Controller components, you can connect to the 

master console using any supported Web browser on your system that is correctly 

configured. 

Perform the following steps to configure the browser: 

1.   Ensure that the browser settings allow new windows (pop-ups) to automatically 

open when you visit a Web site. 

2.   Uninstall or turn off any applications on the system that cause the browser to 

block or suppress pop-up windows. 

Your browser is now configured to use the SAN Volume Controller Console. 

Installing the SNMP service 

This topic describes how to install the SNMP services. 

You must install the SNMP service if it was not installed when you installed the 

operating system. Perform the following steps to install the SNMP service: 

 1.   Click Start-->Settings-->Control Panel. 

 2.   Double-click Add/Remove Programs. 

 3.   Click Add/Remove Windows components on the left side of the panel. 

 4.   Click Management and Monitoring Tools, and then click Details. 
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5.   Check Simple Network Management Protocol, and click OK. 

 6.   Click Next to complete the installation process. 

 7.   From the Control Panel, double-click Administrative Tools. 

 8.   Double-click Computer Management. 

 9.   Expand Services and Applications. 

10.   Click Services. 

11.   In the list of services, double-click SNMP Service. 

12.   Click the General tab and select Automatic as the startup type. 

13.   Click the Security tab and perform the following actions: 

a.   Click Add under the Accepted Community Names field, enter public as 

the new community name, and leave the community rights as read-only. 

b.   Ensure that the Accept SNMP packets from any host option is selected. 

Note:  On some operating systems, the default is Accept SNMP packets 

from these hosts, with an empty field underneath for you to specify 

certain hosts. This option causes the NetView® part of the 

installation to fail.

   Related concepts 

   “Service alerts and error notifications” on page 4
This topic provides an overview of the service alerts and error notifications.

Using the installation wizard 

This topic describes the installation process and lists the programs that you can 

install using the installation wizard. 

The master console installation wizard provides the framework for installing all the 

required software for the master console. It ensures that the master console meets 

all prerequisites and launches the installation program for each software component 

that is being installed.

Important:  During the installation process, some products require a system reboot 

after they are installed. Reboot the system any time that you are 

prompted to do so. After each system reboot, the master console 

installation wizard continues the installation process from the point 

where it was interrupted by the required reboot. 

The installation wizard helps you to install the following products: 

v   Adobe Reader 

v   PuTTY 

v   DB2 

v   SAN Volume Controller Console (optional) 

v   DS4000 Storage Manager Client (FAStT Storage Manager Client) (optional) 

v   Tivoli Storage Area Network Manager (Tivoli SAN Manager) 

v   IBM Director

You must use the master console CD-ROMs to install the master console software. 

   Related reference 

   Chapter 8, “Upgrading the master console to version 3.2,” on page 61
This topic provides information about upgrading the master console to version 

3.2.

 

20 Master Console Installation and User’s Guide

|
|



Logging in 

This topic describes the permissions that are required to perform the master 

console installation. 

To begin installing software on the master console, you must be logged in as a local 

administrator (for example, as the Administrator user) on the system where the 

master console software is to be installed. 

Starting the installation wizard 

This topic describes the steps for starting the installation wizard. 

Before you begin the installation wizard, ensure that you have logged in with a user 

ID that has administrative privileges. 

Perform the following steps to start the installation wizard: 

1.   Insert the Master Console CD-ROM 1 in the CD-ROM drive. 

2.   Click Start—>Run to open the Run dialog. 

3.   Enter cd-rom_drive:\setup.exe, where cd-rom_drive is the letter of the drive in 

which you inserted the CD. Click OK. 

The following message is displayed in the DOS-prompt window. 

+-----------------------------------------------------------+ 

|Initializing InstallShield Wizard...                       | 

|Preparing Java (tm) Virtual Machine .....................  | 

|......................................................     | 

+-----------------------------------------------------------+ 

4.   When you are prompted, select the language to be used for the installation 

wizard and click OK. 

5.   The installation wizard Welcome panel is displayed. Read the information from 

the panel and then click Next. 

6.   The installation wizard License Agreement panel is displayed. Click I accept the 

terms in the license agreement, and then click Next to begin installing the 

Adobe Reader. 

Note:  Before Adobe Reader is installed, the program performs the following 

checks: 

a.   The installation wizard verifies that all software prerequisites are 

installed on the system. If not, a window opens that describes the 

prerequisite software that is not currently installed. When you click 

OK, the installation wizard ends. 

After installing the prerequisite software, start the installation wizard 

again. 

b.   If any hardware requirements are not met on your system, a panel is 

displayed that states that the hardware requirements are not met and 

warns about a decrease in the performance level if these 

requirements are not met.

Installing the Adobe Reader 

This topic describes how to install the Adobe Reader using the master console 

installation wizard. 

Adobe Reader is silently installed by the installation wizard. It allows you to open 

online versions of documentation, such as this document, through a pop-up window. 
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From the Install Acrobat Reader panel of the wizard, click Next to start the 

installation of Adobe Reader. 

When the installation is complete, an information panel is displayed. From this 

panel, you can access this document or IBM Support Web sites by right-clicking on 

the left side of the window. 

Click Next to select the destination directory where you want the master console to 

be installed. 

Choosing the master console destination directory 

This topic describes how to specify the installation directory for the master console 

software when you use the installation wizard. 

Perform the following steps to choose the destination directory: 

1.   By default, the master console is installed in c:\Program Files\IBM\
MasterConsole. To choose a different directory, click Browse and select a 

different directory from the Select a directory dialog box. 

2.   After you specify the destination directory, click Next. 

Selecting the port for the information center 

This topic describes how to select the port value that accesses the master console 

information center. 

Perform the following steps to select a port value: 

1.   Enter a port value between 1 and 65535. To ensure that the port value is not in 

use by another application on your system, open a command prompt and enter 

the command netstat –a to see which port values are in use. 

2.   After entering the information center port value, click Next to display the list of 

optional products that you can select to be installed for the master console.

Selecting the optional features 

This topic describes how to select the optional features to be installed by the 

master console installation wizard. 

Perform the following steps to select the optional features to install: 

1.   Select DS4000 Storage Manager Client (FAStT Storage Manager Client) if 

you want to install that feature, otherwise clear the check box. 

If you clear the DS4000 Storage Manager Client (FAStT Storage Manager 

Client) check box, a message is displayed when you click Next that warns you 

that you must install this feature if DS4000 disk drives are part of the current 

configuration. 

2.   Select SAN Volume Controller Console if you want to install that feature, 

otherwise clear the the check box. 

If you clear the SAN Volume Controller Console check box, a message is 

displayed when you click Next that warns you that you must install this feature if 

the SAN Volume Controller Console is part of the current configuration. 

After you select or deselect the optional features, click Next to display the list of 

products that are to be installed for the master console. 
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Viewing  the products to be installed 

This topic describes the panel that displays the list of products to be installed for 

the master console, and it explains the next steps in the master console installation 

process. 

Using the list of products to be installed for the master console, the installation 

wizard determines if any of these products are already installed and, if so, whether 

the installed version is a later version than the version to be installed. The Product 

List panel lists the following results: 

v   Products of the master console stack 

v   Versions of already-installed products 

v   Required versions for the products 

v   Actions to be done by the installation wizard or by you

The table containing the list of the products to be installed or upgraded is saved as 

MasterConsoleProducts.htm in the location where the master console is installed. 

Depending on the installed version of each product, the installation wizard 

determines whether to install the product based on the following conditions: 

v   If the product is not installed or its installed version is lower than the desired 

version, the product is installed or upgraded by launching the specific installer of 

the product. 

v   If the product is installed at a version equal to or higher than the desired version, 

the product is left as it is. The corresponding panels that launch and verify the 

specific product installation are skipped. For the products with higher versions 

than the required ones, the installation wizard displays a warning that tells you 

that these products are not tested with the master console. 

v   If a product in the list of products to be installed or upgraded is not properly 

installed on the system, you are asked to continue with the installation by 

reinstalling the product with the product-specific installer. If this action does not 

succeed, you must exit the master console installation wizard, manually remove 

the product from your system, and restart the master console installation wizard. 

v   For DB2, the installation wizard also checks the installed edition. If the installed 

edition is not ″Enterprise Edition,” the installation wizard inserts “*Wrong edition” 

in the Installed Version column. You must manually uninstall the wrong installed 

edition. 

To manually uninstall the wrong installed edition: 

1.   Click Cancel to exit the master console installation wizard. 

2.   Manually uninstall the wrong DB2 edition. 

3.   After you uninstall the wrong edition of DB2, start the master console 

installation wizard again.

After you have reviewed the information presented in the table on this panel, click 

Next. 

Installing PuTTY 

This topic describes how to install PuTTY using the master console installation 

wizard. PuTTY is the SSH client software used by the master console. 

Perform the following steps to install PuTTY: 

1.   From the PuTTY installation panel, click Next to begin the installation of PuTTY. 
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2.   The installation wizard installs PuTTY silently. Wait for the wizard to complete 

the installation. 

3.   From the master console installation wizard, click Next. The installation wizard 

validates the installation of PuTTY. If the validation is not successful, an error 

panel is displayed. If errors were found, correct the errors and start the 

installation wizard again. 

Before you continue with the installation wizard, create an SSH key pair using 

PuTTYgen. You need these keys when you install the SAN Volume Controller 

Console. 

Generating an SSH key pair using PuTTYgen 

Although not part of the master console installation wizard, you must generate SSH 

keys for the SAN Volume Controller. You are prompted for these keys when you 

install the SAN Volume Controller Console. You can leave the installation wizard in 

its current state while you generate the SSH keys. 

Perform the following steps to generate SSH keys on the master console using the 

PuTTY Key Generator (PuTTYgen): 

 1.   Start PuTTYgen by clicking Start → Programs → PuTTY → PuTTYgen. 

 2.   Click SSH2 RSA as the type of key to be generated. 

 3.   Click Generate. 

 4.   Move the cursor around the blank area of the Key section to generate a 

random number. 

 5.   Click Save public key to save the public key. 

 6.   Type icat as the name of the key and click OK. 

 7.   Click Save private key to save the private key. 

 8.   When you are prompted to confirm that you want to create the key without a 

passphrase, click Yes. 

 9.   Type icat.ppk as the name of the key and click OK. 

10.   Close PuTTYgen. 

   Related concepts 

   “Secure Shell (SSH)” on page 6
This topic provides an overview of Secure Shell (SSH).

Installing DB2 

This topic describes how to install DB2 using the master console installation wizard. 

Perform the following steps to install DB2: 

1.   From the Launch DB2 Installation panel, click Next to begin the installation of 

DB2. 

2.   If prompted to insert a different CD, insert it in the CD-ROM drive and enter the 

CD-ROM drive letter in the location field. Then click OK. 

3.   The DB2 setup wizard starts. Using the DB2 setup wizard, perform these steps 

to install DB2: 

a.   From the Welcome to the DB2 Setup Wizard panel, click Next. 

b.   From the License Agreement panel, accept the terms of the license 

agreement and then click Next. 

c.   From the Select the installation type panel, click Next to accept the default 

values. 

 

24 Master Console Installation and User’s Guide

|
|
|

|
|
|
|
|

|
|

|

|

|

|
|

|

|

|

|
|

|

|

|

|
|



d.   From the Select the installation action panel, click Next to accept the default 

value. 

e.   From the Select installation folder panel, click Next to accept the default 

destination. 

f.   From the Set user information for the DB2 Administration Server panel, you 

can use the default user name (db2admin). However, you must specify a 

password. 

Note:  Ensure that Use the same user name and password for the 

remaining DB2 services is selected. This allows you to use this 

same user name and password for the remainder of the DB2 

installation. Otherwise, you are prompted to enter a user name and 

password for several additional panels. 

g.   Click Next. If you are prompted to create the user, click Yes. 

h.   From the Set up the administration contact list panel, select Local → Create 

a contact list on this system, and then click Next. 

Note:  If you receive a warning stating that the SMTP server has not been 

specified, click OK to continue. 

i.   From the Configure DB2 instances panel, select DB2 from the DB2 

Instances list, and then click Next. 

j.   From the Prepare the DB2 tools catalog panel, click Do not prepare the 

DB2 tools catalog on this computer and then click Next. 

k.   From the Specify a contact for health monitor notification panel, click New 

contact, and enter the appropriate information in the Name and Email 

address fields. 

l.   Click Next. 

m.   From the Start copying files panel, click Install to begin installing DB2. 

n.   Click Finish to complete the installation. 

o.   When the IBM DB2 Universal Database Welcome panel starts, click Exit 

First Steps.

4.   From the master console installation wizard, click Next to verify DB2 installation. 

The installation wizard validates the installation of DB2. If the validation is not 

successful, an error panel is displayed. If errors were found, correct the errors 

and start the installation wizard again.

Installing SAN Volume  Controller Console 

This topic describes how to install the SAN Volume Controller Console by using the 

master console installation wizard. 

Perform the following steps to install the SAN Volume Controller Console: 

1.   From the master console installation wizard, click Next to launch the SAN 

Volume Controller Installer wizard. 

2.   From the SAN Volume Controller Installer wizard, perform these steps to install 

the SAN Volume Controller Console: 

a.   From the Welcome panel, click Next. 

b.   From the License Agreement panel, click I accept the terms of the license 

agreement, and then click Next. 

c.   From the Destination Directory panel, click Next to accept the default 

directory. 
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d.   From the PuTTY configuration panel, enter the private key (default is 

icat.ppk) that you created after installing PuTTY. Then, click Next. 

e.   From the CIMOM ports panel, click Next to accept the default ports. 

f.   From the embedded WebSphere Application Server ports panel, click Next to 

accept the default ports. 

g.   From the installation confirmation panel, click Install to install the SAN 

Volume Controller Console. 

h.   Click Finish to complete the installation. 

Note:  If you click View post installation tasks, you can view the steps 

needed to access the SAN Volume Controller Console.

3.   From the master console installation wizard, click Next. 

The master console installation wizard validates the installation of the SAN 

Volume Controller Console. If the validation is not successful, an error panel is 

displayed. If errors were found, correct the errors and start the installation 

wizard again.

Installing the DS4000 Storage Manager Client (FAStT Storage Manager 

Client) 

This topic describes how to install the DS4000 Storage Manager Client (FAStT 

Storage Manager Client) using the master console installation wizard. 

Perform the following steps to install the DS4000 Storage Manager Client (FAStT 

Storage Manager Client): 

1.   From the master console installation wizard, click Next to start the installation of 

the DS4000 Storage Manager Client (FAStT Storage Manager Client). 

When upgrading the DS4000 Storage Manager Client (FAStT Storage Manager 

Client) from a version lower than version 9, the installation wizard automatically 

uninstalls the old version first and then begins the installation of the new 

version, as follows: 

a.   The DS4000 Storage Manager Client (FAStT Storage Manager Client) 

uninstallation panel is displayed. Click Next to remove the old version of the 

product from the system. 

b.   The DS4000 Storage Manager Client (FAStT Storage Manager Client) 

uninstallation verification panel is displayed. Click Next to verify that the 

product was successfully removed from the system. 

c.   The DS4000 Storage Manager Client (FAStT Storage Manager Client) 

installation panel is displayed. Click Next to begin installing the new version 

of the product.

2.   From the DS4000 Storage Manager Client (FAStT Storage Manager Client) 

installation wizard, perform these steps to install the client: 

a.   From the Welcome panel, click Next. 

b.   At the copyright prompt, click OK. 

c.   From the License Agreement panel, click Yes. 

d.   From the Destination Directory panel, click Next to accept the default 

directory. 

e.   When prompted to start the Event Monitor service, click Yes. 

f.   From the Operation Complete panel, click Finish.

3.   From the master console installation wizard, click Next. The master console 

installation wizard validates the installation of the DS4000 Storage Manager 
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Client (FAStT Storage Manager Client). If the validation is not successful, an 

error panel is displayed. If errors were found, correct the errors and start the 

installation wizard again.

Installing Tivoli  SAN Manager 

This topic describes how to install the Tivoli SAN Manager using the master console 

installation wizard. 

Note:  The version of Tivoli SAN Manager that is included with the master console 

is the IBM Tivoli Bonus Pack for SAN Management, which provides the 

same SAN management capabilities as Tivoli SAN Manager for 

environments up to 64 SAN switch ports. If more than 64 SAN ports are 

required in your enterprise, you can purchase the full Tivoli SAN Manager 

product. 

Before you begin installing the Tivoli SAN Manager, ensure that the SNMP service 

is started and that a public community string is defined. In addition, ensure that the 

SNMP Trap service is set to manual and stopped by performing the following steps: 

1.   Right-click My Computer from the desktop, and then click Manage. 

2.   Expand Services and Applications. 

3.   Click Services. 

4.   Select SNMP Service and verify that the status is set to started. 

5.   Right-click SNMP Service and click Properties. 

6.   Click the Security tab and verify that there is a public community name with a 

minimum of Read rights. 

7.   Click OK to close the SNMP Service properties dialog. 

8.   From the list of services, select SNMP Trap Service. Verify that the status is 

not set to started and that the startup type is set to manual.

Perform the following steps to install the Tivoli SAN Manager: 

1.   From the master console installation wizard, click Next to start the installation of 

IBM Tivoli Storage Area Network Manager. 

2.   If you are prompted to insert a different CD, insert it into the CD-ROM drive and 

enter the CD-ROM drive letter in the location field. Then click OK. 

3.   From the Tivoli Storage Area Network Manager setup wizard, perform the 

following steps: 

a.   Select the language to be used for the installation, and click OK. 

b.   From the Controller Firmware Warning panel, click OK. 

c.   From the Welcome panel, click Next. 

d.   From the License Agreement panel, click I accept the terms in the license 

agreement, and then click Next. 

e.   From the Destination Directory panel, click Next to accept the default 

directory. 

f.   From the base port number panel, click Next to accept the default. 

g.   From the data repository panel, click DB2, and then click Next. 

h.   From the Single/Multiple User ID/Password Choice panel, you can decide to 

use the DB2 Administrator user name and password that you specified 

during the DB2 installation for all IDs and passwords on this panel. You can 

also choose to use different IDs and passwords for each of the IDs and 

passwords on this panel. After you make your choices, click Next. 
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i.   Enter the DB2 Administrator user name and password. Confirm the password 

and click Next. 

Note:  If you chose not to use the DB2 Administrator user name and 

password, you are prompted to enter IDs and passwords for DB2, 

Websphere, host authentication, and NetView. 

j.   From the database name panel, click Next to accept the default. 

k.   From the Tivoli Network installation drive panel, click Next to accept the 

default. 

l.   From the installation confirmation panel, click Next. 

m.   When you are prompted, click Finish to complete the installation of the 

Tivoli SAN Manager. Note that the machine restarts and the master console 

installation wizard continues.

4.   From the master console installation wizard, click Next. The master console 

installation wizard validates the installation of Tivoli SAN Manager. If the 

validation is not successful, the Verify Tivoli SAN Manager Installation panel 

displays an error. Correct all errors and restart the master console installation 

wizard. 

Before you continue with the master console software installation, you must disable 

the NetView component of Tivoli SAN Manager from receiving traps from the 

Windows SNMP Trap Service. Both NetView and IBM Director receive traps on the 

same port by default, which can cause a conflict when SNMP traps are sent from 

the SAN File System or the SAN Volume Controller. Therefore, you must configure 

IBM Director to forward traps to NetView (you configure IBM Director to forward 

traps after you install it). 

Perform the following steps to disable the NetView component from receiving 

SNMP traps: 

 1.   Edit the Windows registry by opening a DOS prompt and entering regedit 

from the command line. 

 2.   Locate the key HKEY_LOCAL_MACHINE\SOFTWARE\Tivoli\NetView\
CurrentVersion. 

 3.   Double-click the trapdSharePort162 value name and change its value data to 

0. 

 4.   Right-click the key HKEY_LOCAL_MACHINE\SOFTWARE\Tivoli\NetView\
CurrentVersion and click New → DWORD Value. 

 5.   Change the value name to trapdTrapReceptionPort. 

 6.   Double-click the trapdTrapReceptionPort value name, change its value data 

to an available port number (such as 9950), and select Decimal.

Tip:   Remember the port number that you set here, because you refer to that 

number when you modify the IBM Director configuration. 

 7.   Close the Registry Editor window. 

 8.   Open a Command Prompt window. 

 9.   Remove the NetView service. 

C:\usr\ov\bin\nvservice -remove 

10.   Reinstall the NetView service (which removes the dependency on the SNMP 

Trap Service). 

C:\usr\ov\bin\nvservice -install -username .\NetView -password password 

where password is the password of the local NetView account.
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Installing Tivoli  SAN Manager Agent 

This topic describes how to install the Tivoli SAN Manager agent using the master 

console installation wizard. 

Perform the following steps to install the Tivoli SAN Manager agent: 

1.   From the master console installation wizard, click Next to begin the installation 

of the Tivoli SAN Manager agent. 

2.   If prompted to insert a different CD, insert it in the CD-ROM drive and enter the 

CD-ROM drive letter in the location field. Then click OK. 

3.   Select the language to be used by the Tivoli SAN Manager Agent Setup Wizard, 

and click OK. 

4.   The Tivoli SAN Manager Agent Setup Wizard is launched. From the Setup 

Wizard perform these steps to install the Tivoli SAN Manager Agent: 

a.   From the Software License Agreement panel, click I accept the terms in 

the license agreement, and click Next. 

b.   From the Installation Directory panel, click Next to accept the default 

directory. 

c.   From the Manager name and port number panel, enter localhost for the 

Tivoli Manager name (because both the Manager and the Agent are on the 

master console). Leave the default for the Port Number, and click Next. 

d.   From the Base Port Number panel, click Next to accept the default. 

e.   From the Host Authentication Password panel, enter the password of the 

Host Authentication ID you specified when you installed Tivoli SAN Manager 

- Manager. 

Note:  If you chose to use the DB2 Administrator username and password 

for all IDs when you installed the Tivoli SAN Manager, enter it on this 

panel as well. Otherwise, enter the ID that you specified for the host 

authentication ID when you installed the Tivoli SAN Manager. 

f.   From the Installation Confirmation menu, click Next. 

g.   Click Finish to complete the installation of the Tivoli SAN Manager Agent.

5.   From the master console installation wizard, click Next. The master console 

installation wizard validates the installation of Tivoli SAN Manager agent. If the 

validation is not successful, the Verify Tivoli SAN Manager Agent Installation 

panel displays an error. If errors were found, correct the errors and restart the 

master console installation wizard.

Installing IBM Director 

This topic describes how to install IBM Director using the master console installation 

wizard. 

Perform the following steps to install IBM Director: 

1.   From the master console installation wizard, click Next to begin the installation 

of IBM Director. 

2.   If you are prompted to insert a different CD, insert it in the CD-ROM drive and 

enter the CD-ROM drive letter in the location field. Then click OK 

The IBM Director Setup Wizard is launched. 

3.   From the Setup Wizard, perform the following steps to install IBM Director: 

a.   From the Welcome panel, click Next. 
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b.   From the License Agreement panel, click I accept the terms in the License 

Agreement, and click Next. 

c.   From the Server Plus Pack panel, click Next. 

d.   From the Feature and Installation Directory panel, click the Red x for SNMP 

Access and Trap Forwarding. Click This Feature will be installed on the 

local hard drive, and click Next. 

e.   From the IBM Director service account information panel, fill in the following 

fields: 

v   Domain: Enter the host name for the master console. 

v   User name: Enter a Windows user account that has administrative 

privileges. 

v   Password: Enter the password for the Windows user account (and 

confirm it). 

Click Next. 

f.   From the Encryption Settings panel, click Next to accept the defaults 

g.   From the Software distribution settings panel, click Next to accept the 

defaults. 

h.   Click Install to begin the installation. 

i.   From the Network Drivers configuration window, select the first port and click 

Enable driver. 

j.   From the IBM Director database configuration, make sure that Microsoft Jet 

4.0, which is the default, is selected. Do not select DB2 here. Then click 

Next. 

k.   From the IBM Director Microsoft Jet database configuration, click Next 

because you cannot change any of the Jet database configuration values. 

l.   Click Finish to complete the installation. 

m.   When you are prompted to restart the system, click No.

4.   From the master console installation wizard, click Next. The master console 

installation wizard validates the installation of IBM Director. If the validation is 

not successful, the Verify IBM Director Installation panel displays an error. 

Correct all errors and restart the master console installation wizard. 

After you complete the installation but before you continue with the master console 

installation wizard, you must configure the IBM Director to forward traps to the 

NetView component of Tivoli SAN Manager. 

Perform the following steps to forward traps to the NetView component: 

1.   Open a Command Prompt window. 

2.   Change to the IBM Director snmp directory by issuing the following command: 

cd Director_installation_directory\data\snmp 

where Director_installation_directory is the directory where the IBM Director is 

installed. This directory is C:\Program Files\IBM\Director by default. 

3.   Edit SNMPServer.properties. 

4.   Find the line snmp.trap.v1.forward.address.1=. 

5.   Uncomment the line (delete the # sign), and add the name of the master 

console machine. For example: 

snmp.trap.v1.forward.address.1=master1 

6.   Find the line snmp.trap.v1.forward.port.1=. 
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7.   Uncomment the line (delete the # sign), and add the port that you specified for 

the trapdTrapReceptionPort value in the Windows registry key 

KEY_LOCAL_MACHINE\SOFTWARE\Tivoli\NetView\CurrentVersion\. For 

example: 

snmp.trap.v1.forward.port.1=9950 

8.   Save and close the file. 

9.   Reboot the master console.

Preconfiguring IBM Director 

This topic describes how the master console installation wizard performs some 

preconfiguration tasks for IBM Director. 

IBM Director preconfiguration tasks consist of creating a set of event action plans 

designated for managing specific events generated by the master console system. 

These action plans are imported from configuration archive files that should exist on 

the master console installation package. 

Perform the following steps to launch the IBM Director preconfiguration tasks: 

1.   If at least one of the event action plans is in the installation package, you are 

asked to provide, in the Superuser account panel, a Director superuser 

(member of DirSuper group) name and password needed in the IBM Director 

preconfiguration process. 

Provide the name and password, and click Next to continue. 

2.   Wait for the master console wizard to restart IBM Director and to discover IBM 

Director-managed systems. 

3.   The installation wizard finishes the preconfiguration tasks. If one or more 

configuration files are not found in the installation package, or if an error occurs 

during the creation of event action plans, a message is displayed in a panel 

warning the user that these action plans must be manually created later, after 

the installation is completed. 

Click Next to continue. 

After the master console installation wizard has completed the preconfiguration 

tasks for IBM Director, you need to complete the following steps to ensure that the 

local system account can log on to IBM Director: 

 1.   Close IBM Director. 

 2.   Right-click My Computer from the desktop, and then click Manage. 

 3.   Expand Services and Applications. 

 4.   Click Services. 

 5.   Right-click IBM Director Server and click Properties. 

 6.   Select the Log On tab. 

 7.   Click Local System account and select Allow service to interact with 

desktop. Click Apply. 

 8.   You are prompted that the new properties will not take effect until you stop and 

restart the service. Click OK at the prompt. 

 9.   Click OK to close the Properties dialog. 

10.   Stop the IBM Director service, and then restart it.

   Related tasks 

   “Setting up error notification for the SAN Volume Controller” on page 39
This topic provides an overview of configuring error notifications for the SAN 

Volume Controller. 
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“Setting up the service alert feature for the SAN File System” on page 42
This topic provides an overview of configuring service alerts for SAN File 

System.

Installing documentation and support utilities 

This topic describes how to use the master console installation wizard to install the 

master console documentation, Document Launcher, IBM Connection Manager, 

configuration files, IBM WebSphere Help System, and create the directories 

structure and icons. 

Perform the following steps to copy the documentation files and to install the 

utilities: 

 1.   From the master console installation wizard, click Next to begin installing the 

documentation and support utilities. 

 2.   If prompted to insert a different CD, insert it in the CD-ROM drive and enter 

the CD-ROM drive letter in the location field. Then click OK. 

 3.   The documentation and support utilities are copied. 

 4.   The installation wizard installs the IBMConnection Manager, loads registry info 

and creates the IBM VPN client object. 

 5.   The installation wizard copies Eclipse files of IBM WebSphere Help System 

and installs the master console information center (copies master 

console-specific documentation into the IBM WebSphere Help System). 

 6.   The program installs the IBM master console information center as a service. 

 7.   After all documentation and utilities are installed, the Finish panel is displayed. 

 8.   Review the master console installation log (mclog.txt) to ensure that all 

products are properly installed. The log file is located in 

<installation_directory>\logs, where <installation_directory> is the directory 

where the master console was installed. The default installation directory is 

C:\Program Files\IBM\MasterConsole. 

 9.   Click Finish to complete the installation 

10.   If a system reboot is required, accept the prompt to complete the master 

console installation process.

Mirroring the boot drive 

You can use the Microsoft Windows software mirroring capability to mirror the boot 

drive on the master console. 

Before you mirror the boot drive, ensure that you meet the following prerequisites: 

v   You must have a second drive that is as large or larger than your original boot 

drive. 

v   If the target disk has a partition that is assigned to it (that is, it already has a 

drive letter), perform the following steps to remove the partition: 

1.   Back up any necessary data on the existing partition. When you remove an 

existing partition, you lose any data that is on it. 

2.   Remove the partitioning by right-clicking My Computer, selecting Manage → 

Storage → Disk Management, right-clicking the target disk drive, and then 

selecting Delete Partition

Perform the following steps to mirror the boot drive: 

 1.   Right-click My Computer on the desktop. 

 2.   Click Manage. 
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3.   Click Storage → Disk Management. 

 4.   Right-click the disk icon for the system disk. 

 5.   Convert the disk to a dynamic disk by performing the following actions: 

For Windows 2000 systems: 

a.   Click Upgrade to dynamic disk and then click OK. 

b.   Right-click the disk icon for the disk that you want to become the mirror of 

the system disk. 

c.   Click Upgrade to dynamic disk and then click OK. 

d.   If you receive a warning, click Yes. 

e.   If your system restarts, restart the Disk Management utility. 

For Windows 2003 systems: 

a.   Click Convert to dynamic disk. 

b.   Select both drives and click OK. 

c.   Click Convert. 

d.   Click Yes to continue when you receive an operating system boot warning. 

e.   Click Yes to unmount file systems and to continue. 

f.   Allow the system to reboot. 

g.   Restart the Disk Management utility

 6.   For Windows 2000 systems, right-click the disk icon for the system disk or, for 

Windows 2003 systems, right-click the system disk partition. 

 7.   Click Add Mirror. 

 8.   Select the disk that you want to become the mirror of the system disk, and 

then click Add Mirror. 

 9.   Click OK to continue when you receive a warning indicating that you must 

update the boot.ini file. 

10.   Perform the following steps to update the boot.ini file: 

a.   Double-click My Computer on the desktop. 

b.   Click Tools → Folder options. 

c.   Click the View tab. 

d.   In the Advanced settings list, perform one of the following actions, 

depending on your operating system: 

v   For Windows 2000 systems, select Show hidden files and folders. 

v   For Windows 2003 systems, select Show hidden files and folders and 

clear the Hide protected operating system files option. Click Yes 

when you receive a warning.

e.   In the My Computer window, click Local disk (C:). 

f.   Open the C:\boot.ini file in a text editor. 

Attention: Be cautious when you edit this file and make only the specified 

changes. Do not modify any other lines in this file. 

g.   In the operating system section, add Primary to the end of the operating 

description for the system disk. 

h.   Copy the line for the system disk, change Primary to Secondary, and 

change the system disk (for example, rdisk(0)) to mirrored disk (for 

example, rdisk(1)). The file looks similar to one of following examples. 

Windows 2000 example: 
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[boot loader] 

timeout=30 default=multi(0)disk(0)rdisk(0)partition(1)\WINNT 

[operating systems] 

multi(0)disk(0)rdisk(0)partition(1)\WINNT="Microsoft Windows 2000 Advanced 

  Server Primary" /fastdetect 

multi(0)disk(0)rdisk(1)partition(1)\WINNT="Microsoft Windows 2000 Advanced 

  Server Secondary" /fastdetect

 

Windows 2003 example: 

[boot loader] 

timeout=30 

default=multi(0)disk(0)rdisk(0)partition(1)\WINDOWS 

[operating systems] 

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Windows Server 2003, 

  Standard Primary" /fastdetect 

multi(0)disk(0)rdisk(1)partition(1)\WINDOWS="Windows Server 2003, 

  Standard Secondary" /fastdetect

 

i.   Save and close the file. 

j.   Restart the machine. 

After the machine completes the Power On Self Test (POST), the system 

prompts you to select the Windows operating system to use for the boot 

process 

k.   Select the secondary operating system and press Enter to verify that the 

machine successfully restarts from the mirrored drive. 

l.   Restart the machine again. 

After the machine completes the POST, the system again prompts you to 

select the Microsoft Windows operating system to use for the boot process. 

m.   Select your operating system and press Enter to verify that the machine 

successfully restarts from the system drive.
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Chapter  5.  Configuring  the  master  console  

This topic provides an overview of the steps for configuring the master console. 

Perform the following process to configure your master console: 

 1.   Log on as a local administrator (for example, as the Administrator user) to the 

system where the master console software is installed. 

Note:  If you purchased the software-only master console, skip to step 6 since 

you completed the steps 2 through 5 when you installed the master 

console software. 

 2.   Configure the master console host name. “Configuring the master console host 

name” on page 19 provides more details for this step. 

 3.   Configure the network. “Configuring the network” on page 36 provides more 

details for this step. 

 4.   Configure the browser. “Configuring the browser” on page 37 provides more 

details for this step. 

 5.   Generate an SSH key pair using the PuTTYgen. “Generating an SSH key pair 

using PuTTYgen” on page 24 provides more details for this step. 

 6.   Configure a default PuTTY session only for command-line interface (CLI) 

access. “Configuring a default PuTTY session” on page 37 provides more 

details for this step. 

 7.   Store keys in the SAN Volume Controller Console software. “Storing keys in 

the SAN Volume Controller Console software” on page 38 provides more 

details for this step. 

 8.   Set up e-mail notification and call home for the SAN Volume Controller. 

“Setting up e-mail notification for the SAN Volume Controller” on page 39 and 

“Setting up the call home feature for the SAN Volume Controller” on page 40 

provide more details for this step. 

 9.   Set up e-mail notification for the SAN File System. “Setting up e-mail 

notification for the SAN File System” on page 45 provides more details for this 

step. 

10.   Install your chosen antivirus software on the master console system.

Configuring the master console host name 

You must configure the master console host name as part of the configuration 

process. 

Perform the following steps to configure the host name: 

1.   From the desktop, click Start. 

2.   Right-click on My Computer. 

3.   Click Properties. 

4.   Click Computer Name. 

5.   Click Change. 

6.   Type the master console host name in the Computer name field. 

7.   Click More. 

8.   Type the full path information in the Primary DNS suffix of this computer field. 
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9.   Run the install_path\MasterConsole\Support Utils\mcconfig.exe file, where 

install_path is the drive letter and the directory where the master console is 

installed.

Configuring the network 

You must configure the network by entering the IP addresses for the Ethernet ports. 

Entering IP address for Ethernet port 1 

This topic describes how to configure the IP address for the external Internet 

connection for remote access (Ethernet port 1). 

Tip:  After configuring the connection, you can disable it when you are not using 

remote access. 

Perform the following steps to configure the IP address for the external Internet 

connection: 

1.   From the desktop, right-click the My Network Places icon. 

2.   Click Properties. 

3.   Right-click Local Area Connection 1. 

4.   Click Properties. 

5.   Click Internet Protocol (TCP/IP). 

6.   Click Properties. 

7.   Enter all required information for the IP and DNS addresses. 

8.   Click OK until you return to the desktop. 

9.   Connect Ethernet port 1 to the network. 

   Related reference 

   “Specifying IP information” on page 14
This topic describes the IP configuration information that you specify for the 

master console. 

   “Specifying port assignments” on page 13
You must decide which ports to use for the master console so that you can 

determine the Ethernet cables that you will need. 

   “Cabling options” on page 10
This topic describes the various options for cabling the hardware that runs the 

master console. This information helps you to plan the cabling of the hardware. 

However, to avoid any address conflicts, do not connect the Ethernet cables 

until after you have configured the IP addresses. 

Entering IP address for Ethernet port 2 

This topic describes how to configure the IP address for the internal IP network 

connection (Ethernet port 2). 

Perform the following steps to configure the IP address for the internal network 

connection: 

1.   From the desktop, right-click the My Network Places icon. 

2.   Click Properties. 

3.   Right-click Local Area Connection 2. 

4.   Click Properties. 

5.   Click Internet Protocol (TCP/IP). 
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6.   Click Properties. 

7.   Type all required information for the IP and DNS addresses. 

8.   Click OK until you return to the desktop. 

9.   Connect Ethernet port 2 to the network. 

   Related reference 

   “Specifying IP information” on page 14
This topic describes the IP configuration information that you specify for the 

master console. 

   “Specifying port assignments” on page 13
You must decide which ports to use for the master console so that you can 

determine the Ethernet cables that you will need. 

   “Cabling options” on page 10
This topic describes the various options for cabling the hardware that runs the 

master console. This information helps you to plan the cabling of the hardware. 

However, to avoid any address conflicts, do not connect the Ethernet cables 

until after you have configured the IP addresses. 

Configuring the browser 

If you plan to access the SAN Volume Controller Console using a browser other 

than the one that is preinstalled on the master console system, use the 

configuration instructions of your chosen browser to ensure that new windows 

(pop-ups) can automatically open when you visit a Web site. Also, uninstall or turn 

off any applications that block or suppress pop-up windows. 

Generating an SSH key pair using PuTTYgen 

You must generate SSH keys for the SAN Volume Controller. 

Perform the following steps to generate SSH keys on the master console using the 

PuTTY Key Generator (PuTTYgen): 

 1.   Start PuTTYgen by clicking Start —>Programs —> PuTTY —> PuTTYgen. 

 2.   Click SSH2 RSA as the type of key to be generated. 

 3.   Click Generate. 

 4.   Move the cursor around the blank area of the Key section to generate a 

random number. 

 5.   Click Save public key to save the public key. 

 6.   Type icat as the name of the key and click OK. 

 7.   Click Save private key to save the private key. 

 8.   When you are prompted to confirm that you want to create the key without a 

passphrase, click Yes. 

 9.   Type icat.ppk as the name of the key and click OK. 

10.   Close the PuTTYgen.

Configuring a default PuTTY session 

This topic explains how to configure a default PuTTY session so that you can run 

SSH from a command-line interface. 

You must perform these steps only if you are planning to run the PuTTY from a 

command prompt window and you are using private and public keys.
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Remember:  Keys are required for the SAN Volume Controller, but they are not 

required for the SAN File System. 

Perform these steps to configure the PuTTY session on the master console: 

 1.   Click Start —>Programs —> PuTTY —> PuTTY to open the PuTTY 

Configuration GUI window. 

 2.   In the categories pane, make sure that Session is selected. 

 3.   Select SSH as the protocol under the PuTTY basic options. 

 4.   In the categories pane, click Connection —> SSH. 

 5.   Select 2 as the preferred SSH protocol version. 

 6.   In the categories pane, click Auth. 

 7.   Type the fully-qualified file name of the SSH client private key file that you 

specified when you used the PuTTY Key Generator in the Private key file for 

authentication field in the Authentication Parameters. For example, C:\Support 

Utils\PuTTY\icat.ppk. 

If you do not know the file name, you can click Browse to select the file name 

from the system directory. 

 8.   In the categories pane, click Session. 

 9.   In the Saved Sessions window, click Default Settings. 

10.   Click Save to save your settings.

Storing keys in the SAN Volume  Controller Console software 

This topic describes how to store your SSH keys in the SAN Volume Controller 

Console software. When the keys that are used to communicate with the SAN 

Volume Controller are changed, you must store a copy of the new private key in the 

SAN Volume Controller Console software. 

Perform the following steps to store a copy of the new private key in the SAN 

Volume Controller Console software: 

1.   Open a command prompt window by clicking Start —>Run. 

2.   Type cmd.exe in the Open box. Click OK. 

3.   Type the following command: 

copy path\filename C:\″Program Files″\IBM\svcconsole\cimom\icat.ppk 

where path\filename is the path and the file name where you stored the SSH 

private key when it was generated in the previous procedure.

Note:  Directory names with embedded spaces must be surrounded by double 

quotation marks. 

4.   Stop and start the IBM CIM Object Manager to make the change take effect. 

Perform the following: 

a.   Click Start —>Settings —> Control Panel. 

b.   Double-click Administrative Tools. 

c.   Double-click Services. 

d.   From the list of services, right-click IBM CIM Object Manager. Select Stop 

and wait for Windows to stop the service 

e.   From the list of services, right-click IBM CIM Object Manager. Select Start.
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Setting up error notification for the SAN Volume  Controller 

This topic provides an overview of configuring error notifications for the SAN 

Volume Controller. 

Before you perform these procedures, ensure that the following prerequisites are 

met: 

v   The SAN Volume Controller must be installed and configured. 

v   You know the serial number of the SAN Volume Controller.

You can configure the IBM Director to alert your system administrator through 

e-mail when errors or events are logged by the SAN Volume Controller. You can 

also choose to initiate a call-home message to IBM when failures that require 

service actions are logged by the SAN Volume Controller. 

   Related tasks 

   “Preconfiguring IBM Director” on page 31
This topic describes how the master console installation wizard performs some 

preconfiguration tasks for IBM Director.

Setting up e-mail notification for the SAN Volume  Controller 

This task provides instructions for configuring IBM Director to alert your system 

administrator by e-mail when errors or events are logged by the SAN Volume 

Controller. 

Perform the following steps to configure the IBM Director to notify your system 

administrator of SVC errors and events: 

 1.   Initiate a test SNMP trap to be sent to the master console IP address by 

causing a temporary error on the SAN Volume Controller. For example, 

temporarily remove one of the SAN Volume Controller fibre-channel cables to 

cause error code 1060 to be displayed on the front panel of the SAN Volume 

Controller node. After this error is displayed, replace the fibre-channel cable, 

and delete the entry in the SAN Volume Controller error log. 

 2.   Log on to the master console. 

 3.   From the desktop, double-click the IBM Director console icon to open the 

IBM Director console. 

 4.   Log on to the IBM Director console. 

 5.   Validate that the IBM Director received the test trap that was sent by the SAN 

Volume Controller by using the following steps: 

a.   Double-click the Event Log in the right column of the IBM Director 

console. 

b.   Verify that the test SNMP trap was received. SAN Volume Controller traps 

can be identified by displaying the Event Type field of the log. For SAN 

Volume Controller traps, the field contains text starting with 

SNMP.iso.org.dod.internet.private.enterprises.ibm.ibmProd.190. If the test 

trap was not received, perform one or more of the following actions: 

v   Contact your network administrator to ensure that there is not a 

networking problem. 

v   Verify that the error notification setting on the SAN Volume Controller is 

not set to none. 

v   Verify that the master console IP address has been configured.

c.   Close the Event Log.
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6.   From the IBM Director main panel, click Tasks→Event Action Plan Builder. 

The Event Action Plan Builder panel opens. 

 7.   Expand the Send an Internet (SMTP) E-mail hierarchy in the right column of 

the Event Action Plan Builder panel. 

 8.   Double-click 2145EventNot. 

 9.   Type the following information in the form that is displayed: 

a.   Internet E-mail Address: Type an e-mail address (for example, the e-mail 

address of the system administrator). 

b.   Reply to: Type the e-mail address to which you want replies to be 

directed. 

c.   SMTP E-mail server: Type the name or IP address of the SMTP mail 

server. 

d.   SMTP port: Type the port number through which e-mail is sent to your 

e-mail server. The default is 25. 

e.   Subject of E-mail Message: Type 2145 Event Notification. 

f.   Body of E-mail Message: Type any information that you want to be sent to 

the recipient of the e-mail (for example, the machine location information). 

The body of the e-mail also contains all the SNMP trap data that contains 

the details of the event.

10.   Click File->Save. 

11.   Close the Event Action Plan Builder panel. 

12.   Close the main IBM Director panel.

Setting up the call home feature for the SAN Volume  Controller 

This topic provides instructions for configuring IBM Director for the SAN Volume 

Controller error notification and service alert (the call home feature). 

Perform the following steps to configure the master console to support the call 

home feature: 

 1.   Log on to the master console. 

 2.   From the desktop, double-click the IBM Director console icon to open the 

IBM Director console. 

 3.   Log on to the IBM Director console. 

 4.   From the IBM Director main panel, click Tasks → Event Action Plan Builder. 

The Event Action Plan Builder panel opens. 

 5.   Expand the Send an Internet (SMTP) E-mail hierarchy in the right column of 

the Event Action Plan Builder panel. 

 6.   Double-click 2145CallHome. 

 7.   Type the following information in the form that is displayed: 

a.   Internet E-mail Address: If the SAN Volume Controller is located in North 

America, Latin America, South America or the Caribbean Islands, type the 

following address into the field: 

callhome1@de.ibm.com 

If the SAN Volume Controller is located anywhere else in the world, type 

the following address into the field: 

callhome0@de.ibm.com 

b.   Reply to: Type the e-mail address to which you want replies to be 

directed. 
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c.   SMTP E-mail server: Type the name or IP address of the SMTP mail 

server. 

d.   SMTP port: Type the port number through which e-mail is sent to your 

e-mail server. The default is 25. 

e.   Subject of E-mail Message: Type 2145 Error Notification 

f.   Body of E-mail Message: Complete the following text fields. Do not 

change any other fields in the body of the e-mail message. 

# Contact name = contact_name 

# Contact phone number = primary_telephone_number 

# Offshift phone number = offshift_telephone_number 

# Machine location = machine_location 

where contact_name is the name of the person who the IBM service 

representative can contact about this call home request, 

primary_telephone_number is the primary telephone number to use to 

reach the contact person, offshift_telephone_number is the telephone 

number where the contact person can be reached during nonbusiness 

hours, and machine_location is the location of the machine. You can enter a 

maximum of 72 characters for each field.

 8.   Click File → Save. 

 9.   Double-click 2145Test. 

10.   In the Body of E-mail Message section of the form that displays, type the 

same information that you entered in step 7f along with the following 

information: 

# Machine Type/Model = type_model 

# Serial Number = serial_number 

where: 

v   type_model is the machine type and model of the installed SAN Volume 

Controller that is involved in this call home request. Possible values for 

type_model are 21454F2 (default) or 21458F2. The default value is 

21454F2. Do not enter any hyphens when you type the machine type and 

model. 

v   serial_number is the serial number of the SAN Volume Controller that is 

involved in this call home request. To find the value for serial_number on 

4F2 models, find the serial number label, which is located on the right edge 

of the front panel. For the 8F2 model, the label is located on the center of 

the front panel. Do not enter any hyphens when you type the serial number.

11.   Click File → Save. 

12.   Right-click 2145Test and select Test. 

A call-home record is generated. An IBM service representative will call you 

within 24 hours to confirm that the call-home test has been successful. If you 

do not receive a phone call, report this to IBM as a call-home failure. 

13.   Close the Event Action Plan Builder panel. 

14.   Close the main IBM Director panel. 

Note:  The action plan is preconfigured. If this becomes corrupted, the 

call-home function and event notifications will fail and, before you 

continue, you must recover the data.

   Related concepts 

   “Recovering Action Plan preconfiguration data” on page 49
IBM Director is preconfigured to help you set up error notification for the SAN 
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Volume Controller. If this preconfiguration data becomes corrupted, the call 

home function and event notifications fail. 

Setting up the service alert feature for the SAN File System 

This topic provides an overview of configuring service alerts for SAN File System. 

The service alert feature works as follows: 

1.   The SAN File System raises an SNMP trap as the result of a detected error. 

2.   IBM Director on the master console receives notification of the trap. 

3.   IBM Director collects the trap and sends a specifically formatted e-mail to the 

specified system administrator. 

Note:  When an alert is sent by SAN File System, the system administrator can 

contact IBM Support Center if assistance is needed.

To configure service alerts, you must compile the MIBs for the SAN File System 

and the RSA II adapter, and configure Service Alerts. You can also set up e-mail 

notification. 

   Related tasks 

   “Preconfiguring IBM Director” on page 31
This topic describes how the master console installation wizard performs some 

preconfiguration tasks for IBM Director.

Compiling MIBs for the SAN File System 

This topic describes how to compile MIBs for the SAN File System on the master 

console. 

The SAN File System cluster must be installed and operational and the metadata 

server must have been configured to send traps to the master console. 

You must compile MIBs for the SAN File System Service Alert feature and for the 

RSA II adapter. 

Perform the following steps to compile the Service Alert MIB. 

1.   Use secure copy to copy the MIB from the metadata server to the master 

console: 

a.   Open a DOS command prompt on the master console. 

b.   Change to the putty directory (cd /program files/putty) and run pscp to copy 

a file from a metadata server engine. Note that you enter the command on 

one line and that target_file needs to end in the extension .mib. 

pscp -I private_key_file -2 userID@engine_IP_address: 

/usr/share/snmp/mibs/IBM-SANFS-MIB.txt target_file.mib 

If private keys have not been exchanged with the metadata servers, use the 

following syntax: 

pscp.exe -2 userID@engine_IP_address: 

/usr/share/snmp/mibs/IBM-SANFS-MIB.txt target_file.mib 

2.   Open the IBM Director console. 

Note:  When you log in to IBM Director, the password for the IBM Director Login 

window must match the password for the IBM Director Server services. 

3.   In the Tasks menu, click Discover Systems and then SNMP Devices. 
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4.   In the Groups pane on the left side of the panel, expand the All Groups group 

and right-click the SNMP Devices group, then click Compile a new MIB. 

5.   When the window opens, asking you to select the location of the new MIB, click 

the IBM-SANFS-MIB.txt file that you have saved. 

6.   The Status Messages window presents the following: 

MIB file submitted to the server. 

Starting MIB compile... 

MIB Parsing complete 

Resolving MIB imports 

Saving MIB objects... 

MIB Compile Finished. 

7.   Close the Status Messages window. 

8.   Compile the MIB for the RSA II adapter to configure it to send traps as well. 

a.   Download the RSA MIB. The MIB is obtained from the IBM Support Web 

site at http://www.ibm.com/pc/support as part of the firmware package for 

the RSA II adapter. You download the firmware update from IBM as a single 

executable file. 

b.   Run the executable file, which will request that you insert a diskette. The 

diskette is formatted and the updated software is copied to the diskette 

(including the MIB). 

c.   Use the same process for compiling the RSA MIB as for the SAN File 

System MIB. For more information, refer to the RSA II firmware 

documentation. 

   Related tasks 

   “Configuring the service alert feature for the SAN File System”
This task provides instructions for configuring IBM Director for the SAN File 

System error notification and service alert. 

   “Setting up e-mail notification for the SAN File System” on page 45
This task provides step-by-step instructions about setting up your e-mail 

notification for the SAN File System.

Configuring the service alert feature for the SAN File System 

This task provides instructions for configuring IBM Director for the SAN File System 

error notification and service alert. 

The SAN File System management information base (MIB) must have been 

compiled on the master console. In addition, the SAN File System cluster must be 

installed and operational, and the metadata servers must have been configured to 

send traps to the master console. See the SAN File System Installation and 

Configuration Guide for information about configuring SNMP traps on metadata 

server engines. 

Perform the following steps to configure the master console to support the Service 

Alert feature: 

 1.   Verify that the metadata servers can send Simple Network Management 

Protocol (SNMP) traps to the master console. From the master metadata 

server, run the following snmptrap commands. Note that the quote marks are 

two single quotes: 

snmptrap -v 2c -c public master_console_IP_address ’’ SNMPv2-MIB:coldStart 

  

snmptrap -v 2c -c public master_console_IP_address ’’ IBM-SANFS-MIB:sanfsGenericTrap 

where master_console_IP_address is the IP address or host name of the 

master console. 
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2.   Log on to the master console. 

 3.   From the desktop double-click the IBM Director console icon to open the IBM 

Director console. 

 4.   Log on to the IBM Director console. 

 5.   Validate that IBM Director received the traps sent by the SAN File System 

master metadata server. 

a.   Double-click Event Log in the right column of the IBM Director console. 

b.   Verify that the SNMP traps were received. Look for the metadata server 

hostname or IP address under the Sender Name column. If the traps were 

not received: 

v   Contact your network administrator to ensure that there was not a 

networking problem. 

v   Make sure that the SAN File System sent the traps.

c.   Close the event log.

 6.   From the IBM Director main panel, click Tasks. 

 7.   In the Tasks menu, click Event Action Plan Builder. The Event Action Plan 

Builder window opens. 

 8.   From the Event Action Plan Builder window, right-click Simple Event Filter 

and click New. 

 9.   A new simple event filter builder window opens. Perform the following steps: 

a.   In the Event Type tab, make sure that the Any option is not checked. 

b.   Expand the tree in the Event Type tab to select the following: 

SNMP.iso.org.dod.internet.private.enterprises.ibm.ibmProd. 

ibmSanfsModule.ibmSanfsTraps 

c.   Click File, and then click Save as. 

d.   Enter tankGenericTrap and the name of the event filter and click OK.

10.   Right-click Send an Internet (SMTP) E-mail in the right column of the Event 

Action Plan Builder menu and click Customize. 

11.   Enter the following information in the displayed form: 

v   Internet E-mail address. Fill in an e-mail address to which to send service 

notifications (for example, the e-mail address of the system administrator). 

v   Reply to. Fill in an e-mail address to which to send service notifications (for 

example, the e-mail address of the system administrator). 

v   SMTP e-mail server. Enter the name or IP address of the SMTP mail 

server. 

v   SMTP port. Enter the port number through which e-mail is sent on your 

e-mail server. The default is 25. 

v   Subject of E-mail Message — Enter the following text: IBM SAN FS 

Call-home Notification. 

v   Body of E-mail message — Enter the following text as shown. 

#Machine type=machine_type 

#Device serial number=serial_number 

#Record type=1 

#Component id=software 

#Contact name=contact_name 

#Contact phone=telephone_number 

#Mgmt node=&system 

#Date recvd=&date 

#Time recvd=&time 

where: 
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v   Machine_type is a four-digit device type and three-digit model. 

v   Serial_number is the serial number of the master engine in the cluster. 

v   The contact_name and telephone_number can be any length and format. 

v   The values &system, &date, and &time are entered exactly as shown. They 

are not variables.

Note:  E-mails will include the text of the service alert message. 

12.   Click File, and then click Save As. 

13.   Enter IBM SAN FS Call-home Notification as the name of the e-mail action, 

and then click OK. 

14.   Expand the Event Action Plan → Log All Events hierarchy in the left column 

of the Event Action Plan window. 

15.   Expand the Simple Event Filter hierarchy in the middle column of the Event 

Action Plan Builder window. 

16.   Drag the tankGenericTrap event filter from the middle column to Log All 

Events in the left column. 

17.   Click Yes in response to any warning pop-up windows that open. 

18.   Expand the Send an Internet (SMTP) E-mail hierarchy in the right column of 

the Event Action Plan Builder menu. 

19.   Drag the IBM SAN FS Call-home Notification item from the Send an 

Internet (SMTP) E-mail hierarchy to the tankGenerictrap item in the left 

column. 

20.   Click Yes in response to any warning pop-up windows that open. 

21.   Optionally, enable the action history, which will show a history of all events. 

a.   Right-click the action plan that you just created. 

b.   Click Action History. 

c.   Click Enable.

22.   Close the Event Action Builder window. 

23.   Close the IBM Director window. 

   Related tasks 

   “Compiling MIBs for the SAN File System” on page 42
This topic describes how to compile MIBs for the SAN File System on the 

master console.

Setting up e-mail notification for the SAN File System 

This task provides step-by-step instructions about setting up your e-mail notification 

for the SAN File System. 

Perform the following steps to set up your e-mail notification: 

1.   Start IBM Director by clicking the IBM Director Console icon on the desktop. 

2.   From the IBM Director Console menu bar, select Tasks —> Event Action Plan 

Builder. 

3.   In the Actions column, expand the item Send an Internet (SMTP) E-mail. 

4.   Right-click IBM SAN FS Call-home Notification and select Update. The 

Customize Action: IBM SAN FS Call-home Notification panel displays. 

5.   Fill in the following items: 

v   Internet E-mail Address — Fill in an e-mail address (for example, the e-mail 

address of the system administrator) 
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v   Reply to — Fill in the e-mail address to which you want any replies to be 

directed. 

v   SMTP E-mail Server — Fill in the address of your e-mail server. 

v   SMTP Port — Change this, if required, to your SMTP server port number. 

v   Subject of E-mail Message — Fill in SAN File System Event Notification. 

v   Body of E-mail message — Enter the following text as shown. 

# Machine location = Data Centre 

6.   Click File —> Save to save the information. 

7.   Close the Event Action Plan Builder window. 

8.   Close the IBM Director Console window. 

   Related tasks 

   “Compiling MIBs for the SAN File System” on page 42
This topic describes how to compile MIBs for the SAN File System on the 

master console.
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Chapter  6.  Managing  the  master  console  

This section provides an overview of the tasks that you can perform from the 

master console. 

Tasks that you can perform from the master console include: 

v   Starting Tivoli SAN Manager. 

v   Accessing SAN File System. 

v   Initiating remote support. 

v   Replacing the SSH key pair for SAN Volume Controller. 

v   Replacing the client SSH private key known to the SAN Volume Controller 

software. 

v   Setting passwords for Tivoli SAN Manager, DB2, and SAN Volume Controller.

Starting Tivoli  SAN Manager 

This task provides step-by-step instructions about how to start the Tivoli SAN 

Manager. Ensure that you configure the Tivoli SAN Manager to meet your 

requirements. 

Perform the following steps to start Tivoli SAN Manager: 

1.   Double-click Tivoli NetView icon on your desktop, or select Start → Programs → 

Tivoli Console. 

2.   On the menu bar, select SAN → Configuration. 

3.   Click Configuration Manager. 

4.   Select Switches and Other SNMP Agents → SNMP Agents . 

5.   Add the IP address for each Fibre Channel switch into the SNMP Agents list: 

a.   Click Add. 

b.   Type the IP address or name of the Fibre Channel switch and click OK. 

c.   In the SNMP Agents section of the Switches and Other SNMP Agents panel, 

select the entry for the Fibre Channel switch and click Advanced. 

d.   Type the user ID and password for that particular switch (the manufacturing 

defaults for user ID is admin and password is passw0rd). This enables Tivoli 

SAN Manager to access the switch to collect zoning information. 

e.   To enable this access, configure the Fibre Channel switch to allow SNMP 

Command Access. Refer to your Fibre Channel switch documentation for 

procedures on setting up this access.

6.   Verify the installation by running a SAN discovery. From the menu bar, click 

SAN → Configure Manager. This displays the Configure Manager panel 

7.   Select Clear History → OK. 

8.   Select Cancel on the Configure Manager panel. 

9.   Ensure that the Tivoli SAN Manager discovers all expected Fibre Channel 

connections and devices. You can visually check that the Tivoli SAN Manager 

discovers all expected connections and device by displaying the topology map 

for each fabric and seeing that all the expected devices are presented.

Accessing the SAN File System 

This topic describes how to access the SAN File System metadata server engines 

through an SSH session. 
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From the master console, you can access the metadata server engines in the SAN 

File System cluster using PuTTY to establish an SSH session. For more information 

about PuTTY, refer to the PuTTY user’s manual. 

Accessing the SAN File System from the command line 

This topic describes how to access the SAN File System metadata server engines 

through an SSH session from the command line. 

Perform these steps to establish an SSH session to any of the engines in the SAN 

File System from the command line. 

1.   Open a DOS command prompt on the master console. 

2.   Change to the PuTTY directory. 

cd \Program Files\PuTTY 

3.   Run putty to establish an SSH session with a master metadata server engine. 

putty.exe –ssh engine_IP_address –I private_key_file -2 

Note:  If you are not using private/public keys with the SAN File System, omit 

the -I and -2 parameters. 

4.   Log in to the master metadata server engine using a Linux user ID and 

password. 

After connecting to the engine, you can access the SAN File System administrative 

command-line interface (CLI) to run SAN File System commands. These commands 

provide the ability to manage engines, metadata servers, and administrative 

servers. 

In addition, you can perform operating system commands from the SSH session as 

well. 

Accessing the SAN File System from the desktop 

This topic describes how to access the SAN File System metadata server engines 

through an SSH session from the master console desktop. 

Perform these steps to establish an SSH session to any of the engines in the SAN 

File System from the master console desktop. 

Note:  If you are using secure keys, make sure that you have configured SSH to 

use those secure keys. 

1.   Double-click the PuTTY icon. 

2.   Fill in the IP address of the engine to be accessed. 

3.   Select SSH as the protocol. 

4.   Click Open. 

5.   After the session is established, log in using a Linux user ID and password. 

After connecting to the engine, you can access the SAN File System administrative 

command-line interface (CLI) to run SAN File System commands. These commands 

provide the ability to manage engines, metadata servers, and administrative 

servers. 

In addition, you can perform operating system commands from the SSH session as 

well. 
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Transferring  files using pscp 

This topic describes how to use the PuTTY secure copy function to copy files from 

a metadata server engine and the master console. 

Perform these steps to transfer files from a metadata server engine in the SAN File 

System cluster to the master console using secure copy. For more information 

about pscp, see the PuTTY user’s manual. 

1.   Open a DOS command prompt on the master console. 

2.   Run pscp to copy a file from a metadata server engine. 

pscp.exe userID@engine_IP_address:source_file target_file –I 

private_key_file –2

Transferring  files using psftp 

This topic describes how to use the PuTTY ftp function to transfer files between a 

metadata server engine and the master console. 

Perform these steps to transfer files between a metadata server engine in the SAN 

File System cluster and the master console using FTP. For more information about 

psftp, refer to the PuTTY user’s manual.. 

1.   Open a DOS command prompt on the master console. 

2.   Start the psftp session. 

psftp 

3.   Open a connection to the metadata server engine. 

open userID@engine_IP_address 

4.   Change to the appropriate directory on the metadata server (for example, type 

cd /path). 

5.   Change directories to the appropriate directory on the master console (for 

example, type lcd /path). 

6.   Use the put command to transfer files to the metadata server engine and the 

get command to retrieve files from the metadata server engine as shown in the 

following examples: 

put file_name new_file_name  

or 

get file_name new_file_name 

7.   End the FTP session by entering quit.

Recovering Action Plan preconfiguration data 

IBM Director is preconfigured to help you set up error notification for the SAN 

Volume Controller. If this preconfiguration data becomes corrupted, the call home 

function and event notifications fail. 

Use the following Web site to download the most recent SAN Volume Controller 

Management Information Base (MIB) and preconfiguration recovery files and 

procedures: 

http://www.ibm.com/storage/support/2145 

Note:  Although preconfiguration recovery files exist on the master console, these 

files might not be compatible with the latest version of SAN Volume 

Controller software or with the latest SAN Volume Controller MIB.
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Related tasks 

   “Setting up the call home feature for the SAN Volume Controller” on page 40
This topic provides instructions for configuring IBM Director for the SAN Volume 

Controller error notification and service alert (the call home feature).

Initiating remote support 

When IBM is helping you to resolve a problem with your SAN Volume Controller or 

SAN File System, you might receive a request to invoke an IP connection so that a 

remotely based IBM service representative can access the master console to collect 

additional information about the problem. 

Perform the following steps to initiate a remote service session: 

1.   Invoke the remote service connection. 

2.   Add an additional subnet route. 

   Related concepts 

   “IBM Connection Manager and remote access” on page 3
The IBM Connection Manager component of the master console is VPN 

connection software that provides remote access to the SAN Volume Controller 

Console. 

   “Service alerts and error notifications” on page 4
This topic provides an overview of the service alerts and error notifications.

Invoking a remote service connection 

This topic describes how to invoke a remote service connection. 

Note:  To ensure that the IBM Support Center has the correct access to the master 

console and its various software packages, you might be required to provide 

passwords, including the Administrator password, or you might have to be 

present during the remote service session to input the required passwords. 

Perform the following steps to set up a secure connection to IBM with the IBM 

Connection Manager: 

1.   Double-click the IBM Connection Manager icon in the Master Console folder 

on the desktop to open the IBM Connection Manager window. 

2.   Select IBMVPN from the destination drop-down menu. 

3.   Click Make Connection when you are ready for the IBM remote service 

representative to log in. The status “Disconnected” at the bottom of the window 

changes to “Connected.” 

4.   Click Generate Connection ID. An alphanumerical string displays in the box to 

the right of the Generate Connection ID button. This is your unique connection 

ID. Give this connection ID to the IBM remote service representative. 

5.   After all remote support actions are complete, click Disconnect to terminate the 

connection. 

6.   When prompted to confirm the connection termination, click OK. The status 

“Connected” at the bottom of the window changes back to “Disconnected.” 

7.   To close down the application, click Cancel, and then click OK. 

   Related tasks 

   “Adding an additional subnet route” on page 51
This topic describes how to add a new route for the IBM support network after 

the VPN connection has been established using the IBM Connection Manager.
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Adding an additional subnet route 

This topic describes how to add a new route for the IBM support network after the 

VPN connection has been established using the IBM Connection Manager. 

Perform the following steps to add an additional subnet route. 

1.   Determine the support network IP address of the master console: 

a.   Click Start → Programs → Accessories → Command Prompt. 

b.   Issue the following command: 

ipconfig /all 

The end of the output looks similar to the following example: 

PPP  adapter IBMVPN : 

  

        Connection-specific DNS Suffix  . : 

        Description . . . . . . . . . . . : WAN (PPP/SLIP) Interface 

        Physical Address. . . . . . . . . : 00-53-45-00-00-00 

        DHCP Enabled. . . . . . . . . . . : No 

        IP Address. . . . . . . . . . . . : 198.74.64.60 

        Subnet Mask . . . . . . . . . . . : 255.255.255.255 

        Default Gateway . . . . . . . . . : 

        DNS Servers . . . . . . . . . . . :

 

2.   Determine the support network interface number (IF) by issuing the following 

command: 

route print 

The beginning of the routing table looks similar to the following example: 

====================================================================== 

Interface List 

0x1 ........................... MS TCP Loopback interface 

0x1000003 ...00 02 55 7b 0c 09 ...... Intel(R) 82546EB Based Dual Port 

                                      Network Connection 

0x1000004 ...00 02 55 7b 0c 08 ...... Intel(R) PRO/1000 MT Dual Port 

                                      Network Connection 

0x2000004 ...00 53 45 00 00 00 ...... WAN (PPP/SLIP) Interface 

======================================================================

 

The support network interface is identified as the WAN (PPP/SLIP) Interface. 

The number given is in hexadecimal and must be converted to decimal; for 

example, 0x2000004 (hex) = 33554436 (decimal). 

3.   Add the new route for the support network by issuing the following command: 

route ADD 198.74.64.0 MASK 255.255.252.0 [remote_support_IP] 

IF [IF_decimal_number] Metric 2 

Where remote_support_IP is the master console IP address determined in step 

1 and IF_decimal_number is the interface number that is determined in step 2 

(for example, route ADD 198.74.64.0 MASK 255.255.252.0 168.74.64.60 IF 

33554436 Metric 2). 

4.   Verify that the new route was added by issuing the following command: 

route print 

Find the 198.74.64.0 255.255.252.0 entry in the table. The output looks similar 

to the following example: 
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=========================================================================== 

Interface List 

0x1 ........................... MS TCP Loopback interface 

0x1000003 ...00 02 55 7b 0c 09 ...... Intel(R) 82546EB Based Dual Port 

                                      Network Connection 

0x1000004 ...00 02 55 7b 0c 08 ...... Intel(R) PRO/1000 MT Dual Port Network 

                                      Connection 

0x2000004 ...00 53 45 00 00 00 ..... .WAN (PPP/SLIP) Interface 

============================================================================ 

============================================================================ 

Active Routes: 

Network Destination  Netmask          Gateway         Interface       Metric 

0.0.0.0              0.0.0.0          9.47.101.1      9.47.101.159    1 

0.0.0.0              0.0.0.0          9.47.101.1      192.168.70.105  1 

9.47.101.0           255.255.255.0    9.47.101.159    9.47.101.159    1 

9.47.101.159         255.255.255.255  127.0.0.1       127.0.0.1       1 

9.255.255.255        255.255.255.255  9.47.101.159    9.47.101.159    1 

127.0.0.0            255.0.0.0        127.0.0.1       127.0.0.1       1 

192.168.0.0          255.255.0.0      192.168.70.105  192.168.70.105  1 

192.168.70.105       255.255.255.255  127.0.0.1       127.0.0.1       1 

192.168.70.255       255.255.255.255  192.168.70.105  192.168.70.105  1 

198.74.64.0          255.255.252.0    168.74.64.60    198.74.64.60    2 

198.74.64.0          255.255.255.0    198.74.64.60    198.74.64.60    1 

224.0.0.0            224.0.0.0        9.47.101.159    9.47.101.159    1 

224.0.0.0            224.0.0.0        192.168.70.105  192.168.70.105  1 

255.255.255.255      255.255.255.255  9.47.101.159    9.47.101.159    1 

Default Gateway      9.47.101.1 

============================================================================ 

Persistent Routes: 

 None

 

5.   Verify routing to the support network by issuing the following command: 

ping 198.74.67.235 

   Related tasks 

   “Invoking a remote service connection” on page 50
This topic describes how to invoke a remote service connection.

Replacing the SSH key pair for SAN Volume  Controller 

This topic provides step-by-step instructions for replacing the SSH key pair. 

Note:  

v   If you change the SSH keys that will be used by the master console to 

communicate with the SAN Volume Controller Console you will have to 

store the client SSH private key in the SAN Volume Controller Console 

software as described previously and then store the client SSH public key 

on the SAN Volume Controller cluster. 

v   If you change the IP address of your SAN Volume Controller cluster after 

you have added the cluster to SAN Volume Controller Console, the SAN 

Volume Controller Console will not be aware of the existence of the 

cluster.

To correct this, remove the cluster from the SAN Volume Controller Console and 

add it back again. Perform the following steps: 

 1.   Start the SAN Volume Controller Console by clicking on the desktop icon or by 

using your Web browser to go to http://IP_address:9080/ica, where IP_address 

is the IP address of the master console. The Signon window is displayed. This 

might take a few moments to open. 

 2.   Enter the user ID superuser and the password passw0rd. The Welcome 

window is displayed. 
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3.   Click Clusters from the portfolio. 

 4.   Check the Select box for the cluster for which you wish to replace the key. 

 5.   Click Remove a cluster in the selection box 

 6.   Click Go. 

 7.   Click Clusters from the portfolio. 

 8.   Click Add a cluster in the selection box. 

 9.   Input the IP address of the cluster. 

10.   Do not check the Create (Initialize Cluster) box. 

11.   Click OK. 

12.   Enter the user name and password. When you see the pop-up window, enter 

the network password and click OK. 

13.   Add the SSH client public key to the SAN Volume Controller cluster: 

a.   Click Browse... for the key file to upload and locate the public key or input 

the key in the Key (direct input) field 

b.   Type an identifier in the ID field, which uniquely identifies the key to the 

cluster. 

c.   Select the Administrator radio button. 

d.   Click Add Key. 

e.   Click Clusters from the portfolio to check the status of the cluster. If the 

cluster status remains SSH Key Refused, you do not have a good key 

pair. You can reset the SAN Volume Controller Console private SSH key. 

However, if you have successfully contacted other clusters, you will break 

that connectivity.

Replacing the client SSH private key known to the SAN Volume  

Controller software 

This task provides step-by-step instructions to replace the client SSH private key 

known to the SAN Volume Controller software. 

Attention:  If you have successfully contacted other SAN Volume Controller 

clusters, you will break that connectivity if you replace the client SSH private key 

known to the SAN Volume Controller software. 

Perform the following steps to replace the client SSH private key: 

1.   Sign off the SAN Volume Controller Console. 

2.   Using the Windows Services facility, stop the IBM CIM Object Manager: 

a.   Click Start —> Settings —> Control Panel. 

b.   Double-click Administrative Tools. 

c.   Double-click Services. 

d.   Select IBM CIM Object Manager in the list of services, right click, and 

select Stop. 

e.   Leave the Services panel open.

3.   Copy the client SSH private key into the appropriate SAN Volume Controller 

Console directory. Perform the following: 

a.   Open a command prompt window by clicking Start —> Run. 

b.   Type cmd.exe in the Open field. 

c.   Click OK.

4.   Type the following command: 
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copy filename C:\program files\IBM\svcconsole\cimom\icat.ppk 

where filename is the path and file name of the client SSH private key 

5.   Restart the IBM CIM Object Manager. Select IBM CIM Object Manager in the 

list of services, right click and select Start. 

6.   Log on to the SAN Volume Controller Console. 

7.   Click Clusters in the portfolio. 

8.   Check the status of the cluster.

Setting passwords 

This topic lists the passwords that you must set on the master console. 

The following passwords must be set on the master console: 

v   Tivoli SAN Manager (changing the Host Authorization) 

v   DB2 user IDs and passwords 

v   SAN Volume Controller user ID and password

Changing the Host Authorization for Tivoli  SAN Manager password 

This topic describes how to set the Host Authorization for Tivoli SAN Manager 

password on the master console. 

Note:  Verify that the file C:\Support Utils\ChangeWASAdminPass.bat is present. If 

not, download it into the C:\Support Utils directory from the 2145 Support 

Web site, by selecting Downloadable files from the following URL: 

www.ibm.com/storage/support/2145 

These IDs and passwords are used internally by the master console, and can be 

changed if required. 

You can change this password by performing the following steps: 

1.   Open a command prompt window by selecting Start —> Programs —> 

Accessories —> Command Prompt. 

2.   Type cd C:\Support Utils. 

3.   Type ChangeWASAdminPass new_user_ID new_password. 

4.   Reboot the master console.

Setting the DB2 user IDs and passwords 

This topic describes how to set the DB2 user IDs and passwords on the master 

console. 

You can change the DB2 user IDs and passwords by performing the following 

steps: 

1.   Use the Computer Management Administrative tool to change the password for 

the Base User ID password (db2admin): 

a.   Select Start —> Settings —> Control Panel. 

b.   Double-click Administrative Tools —> Computer Management —> Local 

Users and Groups from the left-hand navigation.

2.   Use the Computer Management Administrative tool to change the database 

password used by Tivoli SAN Manager. If it is changed, you must perform the 

following steps: 
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a.   Open a command line window by selecting Start —> Programs —> 

Accessories —> Command Prompt. 

b.   Enter cd c:\tivoli\itsanm\manager\bin\w32-ix86. 

c.   Enter srmcp -u userID -p password ConfigService setAuthenticationPw 

newPassword where userID is your user ID, password is your password, and 

newPassword is the new host authentication password.

Setting SAN Volume  Controller user ID and password 

This topic describes how to set the SAN Volume Controller user ID and password 

on the master console. 

These are set using the SAN Volume Controller Web pages accessed using a Web 

browser or using the SAN Volume Controller Console function. See the SAN 

Volume Controller documentation for more information about changing the ID and 

password. 
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Chapter  7.  Removing  master  console  software  

This topic provides a high-level overview of the procedures for removing the master 

console software. 

To remove the master console software, you must explicitly remove the components 

separately using the Microsoft Windows Add or Remove Programs dialog box. 

Because of product dependencies, you must remove the software packages in the 

following order: 

1.   IBM Director 

2.   Tivoli SAN Manager Agent 

3.   Tivoli SAN Manager 

4.   DS4000 Storage Manager Client (FAStT Storage Manager Client) 

5.   SAN Volume Controller Console 

6.   DB2 

7.   PuTTY 

8.   Adobe Acrobat Reader 

9.   Master console

Note:  When you remove the master console, you remove documentation, 

support utilities, and icons. Therefore, you can continue to access all 

product documentation until you remove the master console. The 

documentation is located in <destination_location>\Documents, where 

<destination_location> is the location where the master console was 

installed on the system. The default location is system_drive\Program 

Files\IBM\MasterConsole.

Accessing the Add or Remove Programs dialog panel 

Perform the following steps to access the Add or Remove Programs dialog panel: 

1.   From the Windows menu bar, click Start->Settings->Control Panel. 

2.   From the Control Panel window, double-click the Add/Remove Programs icon.

Uninstalling IBM Director 

This topic describes how to uninstall IBM Director from the master console using 

the Add/Remove Programs dialog panel. 

This procedure assumes that you have accessed the Add/Remove Programs dialog 

panel. 

Perform the following steps to uninstall IBM Director: 

1.   In the Add/Remove Programs panel, scroll to IBM Director, and click to select 

it. 

2.   Click Change/Remove. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish 

5.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product.
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Uninstalling Tivoli  SAN Manager Agent 

This topic describes how to uninstall Tivoli SAN Manager Agent from the master 

console using the Add/Remove Programs dialog panel. 

This procedure assumes that you have accessed the Add/Remove Programs dialog 

panel. 

Perform the following steps to uninstall the Tivoli SAN Manager Agent: 

1.   In the Add/Remove Programs panel, scroll to IBM Tivoli Storage Area Network 

Manager - Agent, and click to select it. 

2.   Click Change/Remove. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish 

5.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product.

Uninstalling Tivoli  SAN Manager 

This topic describes how to uninstall Tivoli SAN Manager from the master console 

using the Add/Remove Programs dialog panel. 

This procedure assumes that you have accessed the Add/Remove Programs dialog 

panel. 

Perform the following steps to uninstall the Tivoli SAN Manager: 

1.   In the Add/Remove Programs panel, scroll to IBM Tivoli Storage Area Network 

Manager - Manager, and click to select it. 

2.   Click Change/Remove. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish 

5.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product.

Uninstalling the DS4000 Storage Manager Client (FAStT Storage 

Manager Client) 

This topic describes how to uninstall the DS4000 Storage Manager Client (FAStT 

Storage Manager Client) from the master console using the Add/Remove Programs 

dialog panel. 

This procedure assumes that you have accessed the Add/Remove Programs dialog 

panel. 

Perform the following steps to uninstall the DS4000 Storage Manager Client (FAStT 

Storage Manager Client): 

1.   In the Add/Remove Programs panel, scroll to the product name, and click to 

select it. 

2.   Click Change/Remove. 
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3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish 

5.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product.

Uninstalling the SAN Volume  Controller Console 

This topic describes how to uninstall the SAN Volume Controller Console from the 

master console. 

Perform the following steps to uninstall the SAN Volume Controller Console: 

1.   Open the Add/Remove Programs window from the Windows Control Panel. 

2.   Find and select IBM TotalStorage SAN Volume Controller Console. 

3.   Click Remove or Change. 

4.   Navigate through the uninstallation wizard, selecting the Next button of each 

panel. 

5.   Wait for the program to be removed, and then click Finish 

6.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product.

Uninstalling DB2 

This topic describes how to uninstall DB2 from the master console using the 

Add/Remove Programs dialog panel. 

This procedure assumes that you have accessed the Add/Remove Programs dialog 

panel. 

Perform the following steps to uninstall DB2: 

1.   In the Add/Remove Programs panel, scroll to IBM DB2, and click to select it. 

2.   Click Change/Remove. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish 

5.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product. 

After removing DB2, you must also remove the following directories: 

v   The directory where DB2 was installed. The default directory is 

system_drive\Program Files\SQLLIB. 

v   The DB2 directory that contains database data,. The default directory is 

system_drive\DB2. 

v   The DB2log directory containing the DB2 log files. The default directory is 

system_drive\DB2.

Uninstalling PuTTY 

This topic describes how to uninstall PuTTY from the master console using the 

Add/Remove Programs dialog panel. 
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This procedure assumes that you have accessed the Add/Remove Programs dialog 

panel. 

Perform the following steps to uninstall PuTTY: 

1.   In the Add/Remove Programs panel, scroll to PuTTY, and click to select it. 

2.   Click Change/Remove. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish

Uninstalling Adobe Reader 

You can uninstall Adobe Reader from the system that is running the master 

console. 

Perform the following steps to uninstall Adobe Reader: 

1.   Open the Add or Remove Programs window from the Windows Control Panel. 

2.   Find and select the line for Adobe Reader in the Add or Remove Programs 

window. 

3.   Click Remove or Change. 

4.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

5.   Wait for the program to be removed, and then click Finish.

Uninstalling the master console 

This topic describes how to uninstall the master console. 

This procedure assumes that you have opened the Microsoft Windows Add or 

Remove Programs dialog box. 

Perform the following steps to uninstall the master console: 

1.   Find and select IBM TotalStorage Master Console for SAN File System and 

SAN Volume Controller in the Add or Remove Programs window. 

2.   Click Remove or Change. 

3.   Navigate through the uninstallation wizard, selecting the Next button of each 

window. 

4.   Wait for the program to be removed, and then click Finish 

5.   If you are prompted to reboot the system, answer yes to reboot the system and 

complete the removal of the product. 

To complete the removal process, you can remove the directory where the master 

console was installed. The default is system_drive\Program Files\IBM\Master 

Console. 
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Chapter  8.  Upgrading  the  master  console  to  version  3.2  

This topic provides information about upgrading the master console to version 3.2. 

Before you begin the following procedure to upgrade to master console version 3.2, 

ensure that you have logged in with a user ID with administrative privileges. 

 1.   Insert the Master Console CD-ROM 1 in the CD-ROM drive. 

 2.   Click Start → Run to open the Run dialog box. 

 3.   Enter cd-rom_drive:\setup.exe, where cd-rom_drive is the letter of the drive in 

which you inserted the CD, and click OK. 

The following message is displayed in the DOS-prompt window: 

Initializing InstallShield Wizard... 

Preparing Java (tm) Virtual Machine 

 4.   When prompted, select the language to be used for the installation wizard and 

click OK. 

 5.   The installation wizard Welcome panel is displayed. Click Next. 

 6.   The installation wizard License Agreement panel is displayed. Click I accept 

the terms in the license agreement, and then click Next to continue the 

upgrading. 

The installation wizard verifies that all software prerequisites are installed on 

the system. If they are not, a pop-up opens describing the prerequisites that 

are not currently installed. Click OK to stop the installation wizard, then install 

the prerequisite software. After you have installed the prerequisites, start the 

installation wizard again. 

 7.   The installation wizard displays the version of the currently installed master 

console. Click Next to continue upgrading. 

 8.   If any hardware requirements are not met on your system, a panel is displayed 

stating the hardware requirements that are not met and warning about a 

decrease of the performance level if these requirements are not met. 

 9.   If the Adobe Acrobat Reader is installed at a lower version than the required 

one or is not installed on your system, the installation wizard panel 

Upgrading/Installing the Adobe Acrobat Reader is displayed. Click Next to 

begin the upgrading or installation of Adobe Acrobat Reader. 

10.   The installation wizard Destination panel is displayed. You can keep the old 

destination location displayed on the panel or select a different location. If you 

select a different location, the installation program first uninstalls the product 

from the old location and then it installs the master console in the new location 

that you specified. 

11.   The installation wizard stops the IBM master console information center 

service. Wait for the installation program to stop this service. 

12.   The installation wizard displays the Select the information center port panel. 

You can keep the old information center port value or change it by selecting an 

unused port value between 1 and 65535. To see the ports that are being used 

by other applications, open a Command Prompt window, and enter the netstat 

-a command. 

13.   The Select the optional features panel is displayed. Select or deselect the 

optional features: 

v   Install DS4000 Storage Manager Client (FAStT Storage Manager Client). If 

DS4000 Storage Manager Client (FAStT Storage Manager Client) is 

deselected, a message is displayed when you click the Next button to warn 
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you that this feature should be deselected only when DS4000 disk drives 

are not part of the current configuration. 

v   Install IBM TotalStorage SAN Volume Controller Console. If SAN Volume 

Controller console is deselected, a message is displayed when you click the 

Next button to warn you that this feature should be deselected only when 

SAN Volume Controller console is not part of the current configuration.

After selecting or deselecting the optional features, click Next to display the list 

of products that will be upgraded by the master console wizard. 

14.   The List of products panel is displayed. The installation wizard displays the list 

of the products of the master console, comparing the installed product versions 

with the required ones in a table with the following columns: 

v   Products of the master console 

v   Versions of the already installed products 

v   Required versions for the products 

v   Actions to be done by the master console installation wizard 

The table containing the list of the products to be installed or upgraded is 

saved as MasterConsoleProducts.htm in the location where the master console 

is installed. 

Depending on the installed version of each product, the installation wizard 

determines whether to install or upgrade the product using the following 

conditions: 

v   If the product is installed and its installed version is lower than the required 

version, the product will be upgraded by launching the specific installer of 

the product. 

v   If the product is installed at a version equal to or higher than the required 

version, the product is not installed. The corresponding panels that launch 

and verify the specific product installation will be skipped. For the products 

with higher versions than the required ones, the installation wizard displays 

a warning telling you that these products were not tested with master 

console. 

v   If a product from the list of products to be installed or upgraded is found to 

be not properly installed on the system, you are asked to continue with the 

installation by trying to reinstall the product with the product-specific installer. 

If this action does not succeed, you need to exit the master console 

installation wizard, manually remove the product from your system, and 

restart the master console installation wizard. 

v   For DB2, if the installed edition is not Enterprise Edition, the installation 

wizard inserts *Wrong edition in the Installed Version column. You must 

manually uninstall the wrong installed edition. To manually uninstall the 

wrong installed edition: 

a.   Click Cancel to exit the master console installation wizard. 

b.   Manually uninstall the wrong DB2 edition. 

c.   After uninstalling the wrong installed edition of DB2, start the master 

console installation wizard again. 

From this panel, click Next to continue upgrading the products. 

15.   All the product upgrades are done by launching the specific installer for each 

product. However, the upgrade is skipped for any product that is already 

installed with the same version or a higher version than the required one. 

If the product-specific installer cannot manage the upgrading, then it is better 

to manually uninstall the old product version and then install the new one using 

the master console installer. 

Note on upgrading DS4000 Storage Manager Client 
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When upgrading DS4000 Storage Manager Client (FAStT Storage Manager 

Client) from a version lower than version 9, the installation wizard automatically 

uninstalls the old version first and then installs the new one, as follows: 

a.   The DS4000 Storage Manager Client (FAStT Storage Manager Client) 

uninstallation panel is displayed. Click Next to remove the old version of 

the product from the system. 

b.   The DS4000 Storage Manager Client (FAStT Storage Manager Client) 

uninstallation verification panel is displayed. Click Next to verify the product 

was successfully removed from the system. 

c.   The DS4000 Storage Manager Client (FAStT Storage Manager Client) 

installation panel is displayed. Click Next to begin installing the new 

version of the product. (Follow the instructions in “Installing the DS4000 

Storage Manager Client (FAStT Storage Manager Client)” on page 26 step 

2 on page 26.) 

d.   The DS4000 Storage Manager Client (FAStT Storage Manager Client) 

installation verification panel is displayed. Click Next to verify the product 

was successfully installed on the system. 

Before you upgrade IBM Director 

Before starting the IBM Director upgrading wizard, the master console wizard 

performs the following actions: 

a.   Stops the IBM Director services (IBM Director Server and IBM Director 

Support Program). 

b.   Checks the Log On As property of the IBM Director Server service (the 

account used to log on to IBM Director). 

c.   If the Log On As property is set to LocalSystem, the master console wizard 

displays a message telling you to change this property value to the user 

name that you intend to use for the IBM Director.

After receiving such a message, you must manually change the Log On As 

property of the IBM Director Server service by following these steps: 

a.   Open the Services window by selecting Start -> Settings -> Control 

Panel -> Administrative Tools -> Services. 

b.   In the Services window, select the IBM Director Server service. 

c.   Right-click on the selected service and select Properties to open IBM 

Director Server Properties. 

d.   Click on the Log On tab and deselect the Local System account radio 

button. 

e.   Select This account radio button and then enter the user ID and its 

password. 

f.   Save the changes by clicking the Apply and then OK buttons.

You need to remember this account and password because you will be asked 

for it when upgrading IBM Director and then after the upgrading when 

preconfiguring IBM Director (see step 16 on page 64). This account value is 

read by the installer as the default value for the IBM Director account when 

upgrading.

Note:  All the individual software packages are provided on CDs with the 

master console. Installation instructions for the software packages are 

located in the individual software installation guides. 

Upgrades to the master console software products are available at the 

following Web site: www.ibm.com/storage/support/2145/. Instructions for 

downloading and installing upgraded software packages are also 

available at this site.
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16.   The IBM Director Superuser Account panel is displayed. You need to enter the 

name and password for the IBM Director superuser to perform the 

preconfiguration tasks. 

17.   The installation program starts the IBM Director Support Program service. Wait 

for Director to start and then discover the Director-managed systems. 

18.   If IBM Director was never preconfigured since its installation (that is, there are 

no action plans for managing specific events defined in the Director), the 

installation program performs the IBM Director preconfiguration tasks. These 

tasks consist of creating a set of action plans designated for managing specific 

events generated by the master console system. These action plans are 

imported from configuration archive files that exist on the installation package. 

If one or more configuration files are not found on the installation package, or if 

an error occurs while action plans are being imported, a message is displayed 

warning that these action plans must be manually created after installation is 

completed. 

19.   The upgrading of the Master Console Documentation and Support Utilities is 

performed in the following steps: 

a.   The installation wizard uninstalls the old documentation and utilities files, 

IBM Connection Manager, Document Launcher, and information center. 

b.   If a system reboot is required, accept the prompt to complete the 

uninstallation. 

c.   From the Documents and Support Utilities installation panel, click Next to 

begin the installation of new documentation and utilities files. 

d.   If prompted to insert a different CD, insert it in the CD-ROM drive and 

enter the CD-ROM drive letter in the location field. Then click OK. 

e.   The documentation and support utilities files are copied. 

f.   The installation wizard installs the IBM Connection Manager, loads registry 

info, and creates the IBM VPN client object. 

g.   The installation wizard copies Eclipse files of the IBM WebSphere Help 

System and installs the master console information center (copying master 

console-specific documentations into the IBM WebSphere Help System). 

h.   The program installs the master console information center as a service. 

i.   After all documentation and utilities are installed, the Finish panel is 

displayed.

20.   Click Finish. 

21.   If a system reboot is required, accept the prompt to complete the master 

console upgrading process. 

22.   Review the master console installation log (mclog.txt) to ensure that all 

products are properly installed. The log file is located in 

<installation_directory>\logs, where <installation_directory> is the directory 

where the master console was installed. The default installation directory is 

C:\Program Files\IBM\MasterConsole.

   Related reference 

   “Using the installation wizard” on page 20
This topic describes the installation process and lists the programs that you can 

install using the installation wizard.
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Chapter  9.  Troubleshooting  the  master  console  

These topics provide information that you need to troubleshoot and resolve 

problems with the master console. 

Recovering from a disk failure on the master console system 

At some point, you might have to recover from a disk failure on the system that 

runs the master console. 

The hard disk drive on the system that runs the master console is actually a 

mirrored pair of hard disks, if you set up mirroring. This strategy protects against 

loss of the master console due to a disk failure. If one of these mirrored pair of disk 

drives fails and must be replaced, perform the following steps: 

 1.   Right-click the My Computer icon on your desktop and select Manage. 

 2.   Select Disk Management. The hard drives display in the right panel. 

 3.   If the failing disk drive displays, right-click the main volume of the drive and 

select Break Mirror. 

 4.   Shut down the computer that runs the master console and replace the failing 

disk drive using the procedures that are detailed in the documentation for your 

replacement hard drive. Ensure that the new drive has its jumpers set the 

same as the drive that is being replaced. The new drive must be the same 

capacity or larger than the drive being replaced. 

Notes:  

a.   It can be difficult to tell which of the two drives has failed. In this 

case, reboot with each drive one at a time to isolate the failed 

drive. 

b.   If the replacement drive has a boot record that is present, erase 

the boot record prior to using the replacement drive. However, if 

the master console computer fails to boot because it cannot find 

the boot record, change the boot sequence in the BIOS to the 

other hard drive.

 5.   Restart the computer. 

 6.   Right-click the My Computer icon on your desktop and select Manage. 

 7.   Select Disk Management. The hard drives display in the right panel. 

 8.   If a disk drive is marked Missing, remove that disk drive by right-clicking the 

drive and selecting Remove Disk. 

 9.   If the new disk drive has a no entry sign that is displayed on it, right-click that 

disk drive and select Write Signature. This removes the no entry sign. 

10.   Right-click the new disk drive and select Upgrade to Dynamic Disk. 

11.   Right-click the volume that you want to mirror and select Add Mirror. The Add 

Mirror wizard is started. 

12.   Use the Add Mirror wizard to configure the second volume. 

13.   Ignore the window for making changes to the boot.ini file. 

The status of both volumes, the existing drive, and the new drive changes to 

Regenerating. After a short period of time, the status shows the percentage of 

regeneration that has completed. When the regeneration completes, the status 

displays as Healthy.
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Troubleshooting  SAN Volume  Controller Console problems 

If you have problems with the SAN Volume Controller Console, you can use the 

instructions in this topic to help you resolve them. 

If the SAN Volume Controller Console closes unexpectedly 

 This problem has the following symptoms: 

v   The following dialog box is displayed: 

You have signed off 

v   The window closes.

To resolve this problem, perform the following actions: 

1.   Before checking for hardware errors, open a new browser window and 

attempt to reconnect to the SAN Volume Controller Console. The logoff 

message is generally caused by the open session timing out (the 

browser window was left open from a previous session). 

2.   If you cannot reconnect, try the following actions to resolve the problem: 

v   Check current memory availability. This problem can be caused by a 

memory failure in the master console, causing it to run with less than 

the required one gigabyte of memory. If there is a memory problem, 

you need to correct it. 

v   Determine if the IP address of the master console has changed since 

the last reboot. If so, reboot the master console to correct the 

problem.

Troubleshooting  Tivoli  SAN Manager problems 

This topic describes how to troubleshoot problems with Tivoli SAN Manager. 

If the Tivoli SAN Manager loses information 

 If Tivoli SAN Manager shows all resources as red (offline or out of contact), 

ensure that you have installed the Ethernet connections correctly using the 

following guidelines: 

v   Port 1 must be connected to the (public) network (such as the rest of 

your LAN). 

v   Port 2 must be connected to the (private) device network—that is, the 

devices that are connected to the SAN Volume Controller nodes or SAN 

File System cluster, the storage controllers, and the SAN switches.

If  the Tivoli SAN Manager shows a black (blank) topology 

 If the Tivoli SAN Manager shows a black (blank) topology, perform the 

following steps: 

1.   Check that the file in use exists in the C:\Program Files\SQLIB\java12\ 

directory. If it does not, shut down Tivoli SAN Manager and run the 

jdbc2 batch file. 

2.   Edit c:\WINNT\system32\drivers\etc\hosts. If the local host is defined, 

verify that it is in the following format: 

IP_address fully_qualified_domain_name short_name 

If it is not, add another entry for the local host using this format.
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Troubleshooting  VPN problems 

If you have problems with the virtual private network (VPN), you can use the 

instructions in this topic to help you resolve them. 

If you are having trouble establishing the VPN connection 

Perform the following steps to resolve the problem: 

1.   Attempt to ping 198.74.67.235 from the master console. If you do not 

receive a response, follow the steps below: 

a.   Ensure that you have added an additional subnet route. 

b.   Run the netstat –rn command and verify that you have results 

similar to the following. 

Note:  The items in bold text can differ depending on the hardware 

that is running the master console.
Newly added:    198.74.64.0    255.255.252.0     198.74.64.21 

  198.74.64.21       2 

Default:        198.74.64.0    255.255.255.0     198.74.64.21 

  198.74.64.21       1 

2.   Perform the following steps to view the IP Security Monitor: 

a.   Issue the following command from a command window on the 

master console: 

ipsecmon 

If there is no information in the Security Associations window, a VPN 

connection is not running. 

b.   Click Options to increase or decrease the refresh value.

3.   Verify that an active tunnel is running. Perform the following steps from 

the master console: 

a.   Ensure that the IBM Connection Manager has started and is 

properly connected. 

b.   View the IP Security Monitor.

4.   If the IBM Connection Manager is repeatedly trying to connect, perform 

the following steps: 

a.   Ensure that the connection is configured properly and that you have 

added additional subnet routes. 

b.   Check the IP Security Monitor to ensure a connection has been 

established. 

c.   Stop and restart the IPSec Service from a command prompt by 

issuing the following commands: 

net stop policyagent 

net start policyagent 

Troubleshooting  Windows boot problems 

If you have problems with the Microsoft Windows booting, you can use the 

instructions in this topic to help you resolve them. 

If Windows does not boot 

 During the Windows boot process, if Windows tries to start but fails with a 

‘blue screen’ with a Inaccessible Boot Device message and another 

reboot does not solve the problem, this could be due to the windows boot 

code being corrupted on the startup device. 
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Perform the following steps to resolve the problem: 

1.   Reboot the computer where the master console resides. 

2.   Press F1 to display the Configuration/Setup menu. 

3.   Select Start Options. 

4.   Select Start Sequence. 

5.   Step down the sequence to the one that contains the hard disk. 

6.   Use the left and right cursor keys to select the other hard disk. For 

example, if the hard disk is set to 1, select 0. If it is set to 0, select 1. 

7.   Press Esc to exit until you get the option to save and exit. Then select 

Yes. 

8.   If the master console boots, proceed with the steps for recovering from 

a master console disk failure. Otherwise, contact your IBM support 

representative.

Viewing  error information on the master console 

This topic describes how to view error information on the master console. 

All of the SAN Volume Controller nodes, SAN File System metadata servers, 

fibre-channel switches, and storage (for example, DS4000), generate SNMP traps 

as a result of events, such as errors and configuration changes. The errors are 

usually sent to the IBM Director and are listed in the Director Event Log. You can 

view all the events with their time stamps to help you determine which event is 

most likely to have caused the problem 

For example, the loss of a fibre-channel path or link because of a cable or GBIC 

fault can result in a number of different events being logged to the Director Event 

Log from the devices at each end of the failing cable, such as a SAN Volume 

Controller, fibre-channel switch, or storage. 

Some SAN component communication, such as fibre-channel path errors, can also 

be seen in the Tivoli SAN Manager topology displays. The link or component, or 

both, are shown in red. If the problem is intermittent, you might see the component 

shown in yellow. For example, you might see a yellow component if there is a loss 

of the link but the link is now restored. 

Loss of only a component (shown in red) without the loss of the fibre-channel path 

(still showing in black) to it can indicate an IP connection problem between the 

master console and the component. Loss of the IP connection between the master 

console and a host can—if that host is the only host with a Tivoli SAN Manager 

Agent installed that has VDisks assigned from that SAN Volume Controller 

cluster—result in one or more SAN Volume Controller nodes also showing in red. 

If you identify a fibre-channel path or link problem, the failure might be the 

fibre-channel cable, GBICs, SAN component, or host adapter at the ends of the 

failing link. 

To resolve the problem, you might have to see the service documentation for the 

link end device involved (SAN Volume Controller, fibre-channel switch, DS4000, 

host) 

If you identify a particular SAN Component failure, see the service documentation 

for that component to resolve the problem. The master console C:\Documents 

directory contains copies of the various component documentation. 
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Appendix.  Accessibility  features  for  the  SAN  File  System  and  

SAN  Volume  Controller  

Accessibility features help users who have a physical disability, such as restricted 

mobility or limited vision, to use information technology products successfully. 

Accessibility features for the SAN File System 

The following list includes the major accessibility features in the SAN File System: 

v   You can use screen-reader software and a digital speech synthesizer to hear 

what is displayed on the screen.

Tip:  The SAN File System Information Center and its related publications are 

accessibility-enabled for the IBM Home Page Reader. 

v   You can operate all features using the keyboard instead of the mouse.

Accessibility features for the SAN Volume Controller 

The following list includes the major accessibility features in the SAN Volume 

Controller. These features support: 

v   Keyboard-only operation. 

v   Interfaces that are commonly used by screen readers. 

v   Keys that are tactilely discernible and do not activate just by touching them 

v   Industry-standard devices for ports and connectors. 

v   The attachment of alternative input and output devices.

Tip:  The SAN Volume Controller Information Center and its related publications are 

accessibility-enabled for the IBM Home Page Reader. You can operate all 

features using the keyboard instead of the mouse. 

Keyboard navigation 

This product uses standard Microsoft Windows navigation keys. 

IBM and accessibility 

See the IBM Accessibility Center for more information about the commitment that 

IBM has to accessibility. 
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Notices  

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 

other countries. Consult your local IBM representative for information on the 

products and services currently available in your area. Any reference to an IBM 

product, program, or service is not intended to state or imply that only that IBM 

product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may be 

used instead. However, it is the user’s responsibility to evaluate and verify the 

operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 

described in this document. The furnishing of this document does not give you any 

license to these patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing 

IBM Corporation 

North Castle Drive 

Armonk, NY 10504-1785 

U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM 

Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation 

Licensing 

2-31 Roppongi 3-chome, Minato-ku 

Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any other 

country where such provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATIONS ″AS IS″ WITHOUT WARRANTY OF ANY KIND, EITHER 

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR 

A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or 

implied warranties in certain transactions, therefore, this statement may not apply to 

you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publication. IBM may make improvements and/or 

changes in the product(s) and/or the program(s) described in this publication at any 

time without notice. 

Any references in this information to non-IBM Web sites are provided for 

convenience only and do not in any manner serve as an endorsement of those 

Web sites. The materials at those Web sites are not part of the materials for this 

IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 

appropriate without incurring any obligation to you. 
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Licensees of this program who wish to have information about it for the purpose of 

enabling: (i) the exchange of information between independently created programs 

and other programs (including this one) and (ii) the mutual use of the information 

which has been exchanged, should contact:

IBM Corporation 

Almaden Research 

650 Harry Road 

Bldg 80, D3-304, Department 277 

San Jose, CA  95120-6099 

U.S.A. 

Any performance data contained herein was determined in a controlled 

environment. Therefore, the results obtained in other operating environments may 

vary significantly. Some measurements may have been made on development-level 

systems and there is no guarantee that these measurements will be the same on 

generally available systems. Furthermore, some measurement may have been 

estimated through extrapolation. Actual results may vary. Users of this document 

may verify the applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those 

products, their published announcements or other publicly available sources. IBM 

has not tested those products and cannot confirm the accuracy of performance, 

compatibility or any other claims related to non-IBM products. Questions on the 

capabilities of non-IBM products may be addressed to the suppliers of those 

products. 

All statements regarding IBM’s future direction or intent are subject to change or 

withdrawal without notice, and represent goals and objectives only. 

This information is for planning purposes only. The information herein is subject to 

change before the products described become available. 

This information contains examples of data and reports used in daily business 

operations. To illustrate them as completely as possible, the examples include the 

names of individuals, companies, brands, and products. All of these names are 

fictitious and any similarity to the names and addresses used by an actual business 

enterprise is entirely coincidental. 

Trademarks 

The following terms are trademarks of the International Business Machines 

Corporation in the United States, other countries, or both: 

v   DB2 

v   DB2 Universal Database 

v   eServer 

v   IBM 

v   NetView 

v   System Storage 

v   Tivoli 

v   TotalStorage 

v   Virtualization Engine 

v   WebSphere 
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v   xSeries

Intel and Pentium are trademarks of Intel Corporation in the United States, other 

countries, or both. 

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in 

the United States, other countries, or both. 

Microsoft and Windows are trademarks of Microsoft Corporation in the United 

States, other countries, or both. 

Linux is a trademark of Linus Torvalds in the United States, other countries, or both. 

Other company, product, and service names may be trademarks or service marks 

of others. 

Electronic emission notices 

The following electronic emission statements apply to this product. The statements 

for other products that are intended for use with this product are included in their 

accompanying documentation. 

China Class A EMC compliance in Simplified Chinese 

Ensure that you are familiar with the China Class A EMC compliance in Simplified 

Chinese statement. 

This is a Class A product. In a domestic environment this product may cause radio 

interference in which case the user may need to perform practical actions.
  

 

Federal Communications Commission (FCC) statement 

Ensure that you are familiar with the Federal Communications Commission (FCC) 

statement. 

This equipment has been tested and found to comply with the limits for a Class A 

digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 

provide reasonable protection against harmful interference when the equipment is 

operated in a commercial environment. This equipment generates, uses, and can 

radiate radio frequency energy and, if not installed and used in accordance with the 

instruction manual, might cause interference to radio communications. Operation of 

this equipment in a residential area is likely to cause harmful interference, in which 

case the user will be required to correct the interference at his own expense. 

Properly shielded and grounded cables and connectors must be used in order to 

meet FCC emission limits. Neither the provider nor the manufacturer is responsible 

for any radio or television interference caused by using other than recommended 

cables and connectors or by unauthorized changes or modifications to this 

equipment. Unauthorized changes or modifications could void the user’s authority to 

operate the equipment. 
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This device complies with Part 15 of FCC Rules. Operation is subject to the 

following two conditions: (1) this device might not cause harmful interference, and 

(2) this device must accept any interference received, including interference that 

might cause undesired operation. 

Japanese Voluntary  Control Council for Interference (VCCI) statement 

Ensure that you are familiar with the Japanese Voluntary Control Council for 

Interference (VCCI) statement. 

This product is a Class A Information Technology Equipment and conforms to the 

standards set by the Voluntary Control Council for Interference by Information 

Technology Equipment (VCCI). In a domestic environment, this product might cause 

radio interference, in which event the user might be required to take adequate 

measures. 

Korean Government Ministry of Communication (MOC) statement 

Ensure that you are familiar with the Korean Government Ministry of 

Communication (MOC) statement. 

Please note that this device has been approved for business purposes with regard 

to electromagnetic interference. If you find that this device is not suitable for your 

use, you can exchange it for one that is approved for non-business purposes. 

New Zealand compliance statement 

Ensure that you are familiar with the New Zealand compliance statement. 

This is a Class A product. In a domestic environment this product might cause radio 

interference, in which event the user might be required to take adequate measures. 

International Electrotechnical Commission (IEC) statement 

This product has been designed and built to comply with (IEC) Standard 950. 

Avis de conformité à la réglementation d’Industrie Canada 

Ensure that you are familiar with the avis de conformité à la réglementation 

d’Industrie Canada. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du 

Canada. 

Industry Canada compliance statement 

This Class A digital apparatus complies with IECS-003. 

United Kingdom telecommunications requirements 

This apparatus is manufactured to the International Safety Standard EN60950 and 

as such is approved in the U.K. under approval number NS/G/1234/J/100003 for 

indirect connection to public telecommunications systems in the United Kingdom. 

European Union (EU) statement 

Ensure that you are familiar with the European Union (EU) statement. 

This product is in conformity with the protection requirements of EU council directive 

89/336/EEC on the approximation of the laws of the Member States relating to 
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electromagnetic compatibility. Neither the provider nor the manufacturer can accept 

responsibility for any failure to satisfy the protection requirements resulting from a 

non-recommended modification of the product, including the fitting of option cards 

not supplied by the manufacturer. 

Radio protection for Germany 

Ensure that you are familiar with the radio protection for Germany. 

Zulassungsbescheinigung laut Gesetz über die elektromagnetische 

Verträglichkeit von Geräten (EMVG) vom 30, August 1995. 

Dieses Gerät ist berechtigt in Übereinstimmung mit dem deutschen EMVG das 

EG-Konformitätszeichen zu führen. 

Der Aussteller der Konformitätserklärung ist die IBM Deutschland. 

Informationen in Hinsicht EMVG Paragraph 3 Abs. (2): 

 Das Gerät erfüllt die Schutzanforderungen nach EN 50082-1 und EN 55022 Klasse A.
  

EN55022 Klasse A Geräte bedürfen folgender Hinweise: 

Nach dem EMVG: ″Geräte dürfen an Orten, für die sie nicht ausreichend entstört 

sind, nur mit besonderer Genehmigung des Bundesministeriums für Post und 

Telekommunikation oder des Bundesamtes für Post und Telekommunikation 

betrieben werden. Die Genehmigung wird erteilt, wenn keine elektromagnetischen 

Störungen zu erwarten sind.″ (Auszug aus dem EMVG, Para.3, Abs.4). Dieses 

Genehmigungsverfahren ist nach Paragraph 9 EMVG in Verbindung mit der 

entsprechenden Kostenverordnung (Amtsblatt 14/93) kostenpflichtig. 

Nach der EN 55022: ″Dies ist eine Einrichtung der Klasse A. Diese Einrichtung 

kann im Wohnbereich Funkstörungen verursachen; in diesem Fall kann vom 

Betreiber verlangt werden, angemessene Massnahmen durchzuführen und dafür 

aufzukommen.″ 

Anmerkung: Um die Einhaltung des EMVG sicherzustellen, sind die Geräte wie in 

den Handbüchern angegeben zu installieren und zu betreiben. 

Taiwan  Class A compliance statement 

Ensure that you are familiar with the Taiwan Class A compliance statement. 
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